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About This Tutorial

• Identify the need for network service 
monitoring tools

• Describe how to use IPM to configure 
and monitor Cisco IOS IP Service 
Level Agreements (IP SLAs)  

• Provide a case study for monitoring 
network protocol response times and 
latency using IPM and IOS IP SLAs

• Provide helpful guidelines for System 
Administrators

• Provide links to helpful 
documentation on CiscoWorks, IPM, 
and IOS IP SLAs

About This Tutorial
The CiscoWorks Internetwork Performance Monitor (IPM) tutorial provides self-paced training focused on 
using IPM for monitoring network service levels using the embedded IP Service Level Agreements (IP SLAs) 
in Cisco IOS devices. This tutorial will focus on how to use and administer IPM to configure and monitor IOS 
IP SLAs.
IPM is available with the purchase of the CiscoWorks LAN Management Solution (LMS) bundle. The LMS 
bundle is a suite of network management applications used for configuring, administering, monitoring, and 
troubleshooting a Cisco-based network. It enables network administrators to effectively manage their LAN 
and campus networks.
The tutorial is structured as a series of self-paced modules, or chapters, that conclude with self-administered 
exercises. Also included as part of the tutorial is a helpful reference section containing links to technical 
documents on component products, concepts, and terminology. The tutorial material is presented through 
text, illustrations, hypertext links, and typical scenarios.
This tutorial is not intended to teach you how to manage network performance issues, but rather to introduce 
you CiscoWorks IPM and Cisco IOS IP SLAs, which will help you achieve these tasks.



© 2005 Cisco Systems, Inc. 
All rights reserved.

Introduction 1-3IPM v2.6 Tutorial

Introduction 1-3© 2005 Cisco Systems, Inc. All rights reserved.IPM v2.6 Tutorial

How the Tutorial Is Organized

Chapter 1
Introduction to Monitoring  

Network Service Levels

Chapter 2
Using IPM & IP SLAs to Monitor 

Network Service Levels

Chapter 3
IPM Case Study

Chapter 4
System Administration 

Guidelines

Chapter 5
Helpful Links to Reference 

Material 

Learn about monitoring network service levels 
and various supporting tools

Learn how IPM can help a user to easily 
configure the IOS IP SLAs and monitor the 

performance of their network

Using an example, learn how IPM can help 
manage network performance issues

Review important system requirements, installation 
guidelines, and system troubleshooting tools

A comprehensive set of links to information on 
IPM and IP SLAs

How This Tutorial Is Organized
The tutorial is divided into five chapters. Each chapter outlines its specific learning objectives, and concludes 
with a series of self-assessment exercises based on the chapter objectives. The multiple-choice exercises 
provide a means for you to assess your understanding of the material presented in a given chapter. A 
summary of each chapter is listed below.

Chapter 1: Introduction to Monitoring Network Service Levels
This chapter identifies the need for monitoring network service levels to maintain user satisfaction and verify 
SLAs. This chapter will first identify the need for testing the network for application response time and 
various tools used to monitor or test the network. Finally, the chapter will introduce IPM and the Cisco IOS IP 
Service Level Agreements (IP SLAs) embedded in Cisco IOS devices as tools for monitoring the network.

Chapter 2: Using IPM and IP SLAs to Monitor Network Service Levels 
This chapter discusses the key features of IPM in a manner that allows you to understand not only the 
product as a whole, but any reason for the individual tasks necessary for using IPM. Before getting into the 
specifics on how to use the various functions of IPM, the chapter discusses its architecture, to provide an 
understanding of how IPM is used to configure IP SLAs. A workflow for using IPM is presented in a logical 
manner showing how you would begin and continue to use its features.
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Chapter 3: IPM Case Study
This chapter walks you through a step-by-step example to provide hands-on experience using IPM. The 
case study begins with steps on how to get started, followed by monitoring activities and customized 
configurations. This example will help to reinforce the information learned in Chapter 2. 

Chapter 4: System Administration Guidelines
This chapter provides information about IPM client and server requirements, software installation 
guidelines, and tips for troubleshooting and avoiding common problems when using IPM. Detailed 
instructions on installing the software can be found in the IPM Installation Guide.  A link to these 
documents can be found in the References section of the tutorial (Chapter 5).

Chapter 5: References
This chapter contains a comprehensive list of additional product information, such as links to related white 
papers and documentation.

Chapter Questions and Answers
This section contains the answers to the questions that conclude each chapter.
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Chapter 1Chapter 1

Introduction to Introduction to 
Monitoring Network Monitoring Network 
Service LevelsService Levels
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Chapter 1 Outline

• Importance of Analyzing Network Service 
Levels

• Verifying SLAs
• Locating bottlenecks
• Calculating protocol response times

• Common Ways to Analyze Network Latency, 
& Response Time

• PING / Traceroute tests
• Third party network analyzers & RMON probes
• IOS IP Service Level Agreements (IP SLAs) & IPM

• A Closer Look at IPM & IP SLAs
• Where to find IPM
• IOS devices supporting IP SLAs

Chapter 1 Outline 
Welcome to the Internetwork Performance Monitor (IPM) Release 2.6 tutorial!  Before introducing IPM, this 
chapter first acknowledges the importance of analyzing network performance.  The network costs money; so, 
get what you pay for!  Monitor the response time of the network to verify your service level agreements from 
service providers.  Additionally, monitoring the network will also help with performance issues by locating 
network bottlenecks and calculating overall response times for upper layer protocols.
Secondly, the chapter will look at different ways network administrators can analyze network performance 
issues.   When there’s a problem, network administrators typically use the PING command to test for 
reachability or the Traceroute command to determine the network path taken by a packet.  More 
sophisticated techniques include the use of third party network analyzers or probes, and embedded agents in 
Cisco network IOS devices, call IOS IP Service Level Agreements or IP SLAs.  And this is where we 
introduce IPM.
IPM is a graphical network management tool to help network administrators configure the IP SLAs and 
retrieve and report on the statistics from them. Find out how IPM can be obtained. And get a quick look at 
how IPM can be a useful application for network administrators to help monitor network SLAs and analyze 
network performance issues.

Note(s):
• For those who have used Cisco’s Response Time Reporter (RTR) or Service Assurance Agents 

(SAA) in previous IOS releases, these features have been renamed to Cisco’s IOS IP SLAs, effective 
September, 2004.

• Starting with IOS 12.3(14)T, the keyword “rtr” in the IOS command line interface will be replaced with 
“ip sla”.

• “RTR Responder” will be renamed to “IP SLA Responder”
• Many of these older feature names are still reflective in IPM v2.6, however, this tutorial will reflect the 

new branding to IP SLA.
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Importance of Importance of 
Analyzing Network Analyzing Network 
Service LevelsService Levels

Importance of Analyzing 
Network Service Levels

• Common Ways to Analyze 
Network Latency

• A Closer Look at IPM / IP 
SLA
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End-Users’ Perspective

“How important is it to understand application 
response time and locating bottlenecks in the 
network?”

No longer is it enough …
– To be reactive to problems…you must be proactive

– To alarm or alert to an outage or service 
degradation….you must receive information before it 
occurs …. 

– To insure adequate application response times and 
reduce costs .. .must insure optimum SLAs are meet

– To understand that network , traffic or applications are 
slow…you must understand “why”

– To make assumptions about projected capacity 
decisions..you need fact to justify expenditures / 
return on investment (ROI)

End-Users’ Perspective
As information systems continue to grow in size, scope, and strategic importance, network managers face 
numerous challenges in managing mission-critical networks that have evolved into an integral component of 
the business itself. The ability to measure network response time, determine device availability, resolve 
connectivity issues, analyze response time patterns, and provide critical reports (both real time and 
historical) have taken on an even higher priority. 
So how do network managers today, evaluate the performance of their network?
A decade ago, every network administrator would analyze their network devices directly from the Command 
Line Interface (CLI) of the device or using common utilities at their workstation.  But times have changed.  
WANs are being outsourced; service level agreements need to be verified.  Network administrators are 
having to do more with less resources.  The enterprise networks are much larger and more complex.  
Performance related issues need to be detected early on and when trouble arises the reasons need to clear 
and determined quickly. 
Thus, many network administrators are using or considering network management tools to help with many of 
the redundant tasks associated with monitoring the network.   



© 2005 Cisco Systems, Inc. 
All rights reserved.

Introduction 1-9IPM v2.6 Tutorial

Introduction 1-9© 2005 Cisco Systems, Inc. All rights reserved.IPM v2.6 Tutorial

The Challenges

To ensure quality-of-service for the end users, evaluate 
protocol response times and network latency

– Response times are the most direct measurement of the user’s 
experience

– Latency is the delay that components in a path add to the overall 
response time

Client –
HTTP 
request

SiSi

4 ms

6 ms
8 ms

25 ms

Server 
Farm

Analyzing …
• Latency hop-by-

hop
• Differences for 

upper layer 
protocols

• Jitter in voice 
traffic

The Challenges
Today, tools are needed to address these challenges with proactive network response time and availability 
management, including both real-time and historical analysis. Network managers require tools to isolate 
performance problems, locate bottlenecks, diagnose latency, perform trend analysis in multi-protocol 
networks, and verify SLAs.  
Some challenges that network managers are faced with include the following.
Pinpointing Network Response Time and Availability Problems
In a large, distributed network, network managers often spend much of their time identifying problems within 
the network as they arise. Network managers not only need to identify that a network delay exists, but where, 
within a network path, the traffic is being delayed. To quickly diagnose problems, performance 
measurements are needed for an entire path and for each hop within the path. 
Pinpointing Source of Problem - Is it the network or server?
When problems with networked applications arise, network managers may spend much of their time 
determining if the problem is within the network or the server. In enterprises with different groups 
administering the network and servers, this diagnosis must be made quickly to ensure a rapid resolution to 
the problem.
Pinpointing Source of Problem - Which provider is responsible?
Today's enterprises often rely on services from multiple service providers to run mission critical networked 
applications.  A telecommunications company may provide wide-area connectivity between the central office 
and remote sites of an enterprise.  An Internet Service Provider connects the enterprise to the Internet.  
Virtual Private Networks (VPNs) between enterprises may be furnished by another service provider.  As a 
result, when a network outage occurs, it can be extremely difficult for a network manager to pinpoint not only 
where in the network the problem occurred, but also which service provider is responsible for the problem.
These are just some of the challenges that network professionals need to deal with in large networks.  Now 
let’s look at some ways these issues can be addressed.
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Common Ways to Common Ways to 
Analyze Network Analyze Network 
LatencyLatency

• Importance of Analyzing 
Network Service Levels

Common Ways to Analyze 
Network Latency

• A Closer Look at IPM / IP 
SLA
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ICMP Ping Command

• Use PING to send 
multiple ICMP packets 
of a specified size to a 
remote IP address

• Reports on packet loss 
and approximate round 
trip time from client 
sending PING to 
remote IP address

• Can not tell you where
the network delay 
occurred

Remote 
IP Address

ICMP Ping Command
A common and easy-to-use troubleshooting technique for network professionals is the use of "ping”.  Ping is 
a utility that uses the ICMP echo request/reply protocol to test for connectivity to an IP address.  Pinging a 
device from a station provides a quick response to device reachability and response time from the station to 
the target IP device.  However, using ping from your station to a remote node may not easily help you identify 
where the problem is in the network since the measurement may be occurring over a different network path 
or over multiple hops.  Also, the use of the ICMP protocol to measure response time does not accurately 
reflect the response time for your application.  An apparently healthy network (i.e. quick ping response and/or 
low utilization) can still mask potential response time problems.  The problem may reside in the upper layers 
of the protocol stack.

Note(s):
• For more information on the ping command, refer to the Cisco Configuration Fundamentals 

Command Reference.
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Traceroute Command

• Shows the network 
path taken between the 
source and a target 
device

• Reports on each hop 
or gateway and how 
long each hop took

• Can tell you where the 
network delay is 
occurring

Remote 
IP Address

?

Traceroute Command
The traceroute command shows the actual routes packets take between devices and can be used to 
detect routing errors between the network management station and the target device. 
By diagnosing TCP/IP Layer 3 (transport) problems, Traceroute helps you understand why ping fails or 
why applications time out. You can view each hop (or gateway) on the route to your device and how long 
each hop took.

Note(s):
• A Traceroute tool is available in the CiscoWorks Device Center
• For more information on the trace command, refer to the Cisco Configuration Fundamentals 

Command Reference.



© 2005 Cisco Systems, Inc. 
All rights reserved.

Introduction 1-13IPM v2.6 Tutorial

Introduction 1-13© 2005 Cisco Systems, Inc. All rights reserved.IPM v2.6 Tutorial

Third Party Network Analyzers or Probes

• Probes monitor and 
collect statistics on all 
packets that traverse 
their interfaces

• Probes can correlate 
and time application 
transaction pairs

• The number of probes 
and placement of 
probes can be a 
daunting task 

ProbesNetwork Analyzers 
or Probes

Third Party Network Analyzers or Probes
Another common tool used for monitoring and troubleshooting response time is the use of network analyzers 
or probes.  A probe is generally a dedicated hardware device that is used to monitor a network segment’s 
performance.  For example, an RMON2 probe can analyze the existing network traffic and report on the 
connected segment's utilization, top talkers, and conversations broken down by upper layer protocols.  
Probes can capture packets and analyze packet header information for an in-depth analysis of the network 
segment’s activity.  
A probe’s report on segment utilization and error counts can possibly assist the network professional in 
pinpointing network delays or problems.  But in order to detect where the delay is within the network, 
numerous probes would need to be deployed along each hop of the application's path.  Although valuable 
information can be obtained from a network analyzer or probe, it may not always be a cost-effective solution 
to solving response time and availability issues.  Dedicated probes are a better fit when conducting network 
baselining and trending link, protocol, and application utilization, as well as, characterizing and identifying the 
top talkers and conversations. 
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Cisco IOS IP Service Level Agreements 
(IP SLAs)

Round Trip
Time

Network
Jitter

Dist. of
Stats ConnectivityPacket

Loss

FTP DNS DHCP TCPJitter ICMP UDPDLSW HTTP

Network
Performance
Monitoring

Service Level Service Level 
AgreementAgreement

(SLA)(SLA)
MonitoringMonitoring

NetworkNetwork
AssessmentAssessment

Multiprotocol 
Label 

Switching 
(MPLS)

Monitoring

VoIP VoIP 
MonitoringMonitoringAvailability Trouble

Shooting

ProtocolsProtocols

Measurement MetricsMeasurement Metrics

ApplicationsApplications

IP HOST

Simulated Protocol Traffic
SOURCE

IP Server

LDP H.323 SIP RTP

MIB

Radius Video

MIB

DESTINATION

Store measurement 
in IP SLA MIB

IP SLA

IP SLAIP SLA

Responder Enabled

Cisco IOS IP Service Level Agreements (IP SLAs) 
Cisco IOS IP SLAs are embedded within Cisco IOS software.  Using IP SLAs, there are no new devices to 
deploy, learn, or manage; Cisco IOS IP SLA provides a scalable, cost-effective solution for network 
performance measurement.
Cisco IOS IP SLAs collect network performance information in real time: response time, one-way latency, 
jitter, packet loss, voice quality measurement, and other network statistics. The user can continuously, 
reliably, and predictably measure network performance and proactively monitor network health. With Cisco 
IOS IP SLA, service level monitoring is automated, IP service levels can be assured, network operation can 
be verified proactively, and network performance can be accurately measured. Active monitoring 
continuously measures the network performance between multiple paths in the network, providing an 
ongoing performance baseline.Network administrators can also use Cisco IOS IP SLA as a troubleshooting 
tool. They can obtain hop-by-hop performance statistics between two Cisco routers or between a router and 
a server. If the network performance level drops during the operation (ie: due to congestion), the network 
administrator can promptly identify the location of the bottleneck and resolve the problem. Cisco IOS IP SLA 
can also perform a network assessment for a new IP service and verify Quality of Service (QoS) levels.  
Cisco IOS IP SLA measures performance by sending one or more simulate protocol test packets to a 
destination IP device or a Cisco router. Cisco IOS IP SLA uses the timestamp information to calculate 
performance metrics such as jitter, latency, network and server response times, packet loss, and Mean 
Opinion Score (MOS) voice quality scores.

Note(s):
• IP SLAs was previously known as the Response Time Reporter (RTR) and Service Assurance Agents 

(SAAs) in earlier IOS versions..
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Products Supporting IP SLAs

THIRD PARTY PRODUCTS

Enterprise performance measurements

MPLS VPN and SLA Monitoring

CiscoWorks IPM

Cisco IP Solution Center

Cisco Network Management Solution

Products Supporting IP SLAs
Cisco IOS IP SLAs integrates with several industry-leading performance management applications, which 
provide graphical user interfaces for configuring the IP SLA operations, analyzing its performance metrics, 
and producing detailed reports.  The following vendors and their applications rely on Cisco IOS IP SLAs to 
collect performance measurements:
Cisco Systems

• CiscoWorks Internetwork Performance Monitor (IPM)
• IP Solution Center

Agilent
• Agilent OSS QoS Manager

Concord
• eHealth

Crannog Software
• Response Watch

InfoVista
• VistaView

Quallaby
• PROVISO

HP Openview
• Performance Insight

Micromuse ISM
• ISM

Wired City
• IT Monitor
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A Closer Look at IPM / A Closer Look at IPM / 
IP SLAIP SLA

• Importance of Analyzing 
Network Service Levels

• Common Ways to Analyze 
Network Latency

A Closer Look at IPM / IP 
SLA
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Internetwork Performance Monitor (IPM)

• User interface to 
configure the synthetic 
test traffic sent by the 
IOS IP SLAs

• IPM can retrieve, 
analyze, display & 
store the real-time 
statistics from IP SLAs 
for historical reporting

• IPM provides proactive 
notification of 
exceeded thresholdsPacket Loss

Internetwork Performance Monitor - Overview
Cisco IOS IP SLAs could be configured at the IOS devices CLI.  But IPM provides a better solution – a 
graphical user interface to configure and collect data from each IP SLA in the network. Additionally, the 
following statistics can be used for trending or baselining by storing the statistics on the IPM server for 
historical reporting.

• Response time
• One-way latency, round-trip latency, hop-by-hop latency for multiple paths
• Jitter in packet arrival at destination
• Packet loss
• Website download time
• And more.

IPM also provides the mechanism to monitor performance for different class of traffic over the same 
connection using IP Precedence or DSCP (Differentiated Services Code Point). 
Threshold settings on network latency or jitter can trigger SNMP traps to alert network administrators of 
service level related issues.
IPM can also use the IP SLAs statistics as a troubleshooting tool. Network administrators can use it to obtain 
hop-by-hop performance statistics between two Cisco routers. If the network performance level drops during 
operation, for example, due to congestion, the network administrator can promptly identify the location of the 
bottleneck and resolve the problem.
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Where to Find IPM

• IPM is available in the 
CiscoWorks LAN 
Management Solution 
(LMS) bundle v2.5 or 
later

• All applications within 
a CiscoWorks bundle 
require the CiscoWorks 
Common Services to 
be installed 

Internetwork
Performance Monitor

Device Fault
Manager

Campus Manager

Resource Manager
Essentials

CiscoView

LAN Management 
Solution
(LMS) 

CiscoWorks Common Services

Where to Find IPM
IPM v2.6 is available in only the new CiscoWorks LAN Management Solution (LMS) v2.5 bundle .  
The applications within the CiscoWorks LMS bundle all rely upon the CiscoWorks Common Services (CCS) 
software that is installed on the CiscoWorks server.  These services provide the necessary background 
processes for the database, web services, network discovery, process management,  security, and more.
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Cisco Devices that Support IP SLAs

Cisco 800
Series

Cisco 1700
Series

Cisco 3700
Series

Cisco 2600
Series

Cisco 7300
Series

Cisco Catalyst 
6500; Cisco 
7600 Series

Cisco 10000
Series

Cisco 12000 
Series

Cisco 7200 
Series

Cisco 4500
Series

Enterprise & Aggregation/Edge

Cisco IOS Software Release 12.2S

Cisco 2900, 
3550, & 

3750 Series
Cisco 7200 & 
7300 Series

Access

Core

Cisco IOS Software Releases 12.3T and 12.4

Cisco Devices that Support IP SLAs
Most Cisco IOS platform types provide support for the IP SLAs agent as illustrated above.  The IOS software 
release levels depicted use the newly renamed IP SLAs agent software.  Earlier IOS releases are still 
supported, however, IP SLAs are known as Response Time Reporter (RTR) or Service Assurance Agents 
(SAAs).
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IOS Versions that Support IP SLAs

X
X
X
X
X

X

X
X
X
X
X
X
X
X

X
X

12.2(11)T
(Infra2)

X

X

X
X
X
X
X
X
X
X
X
X
X

12.2(14)S

X
X
X
X
X
X
X
X
X
X
X

12.1
E

XXXXSNMP Support

X
X
X
X
X

X

X
X
X
X
X
X
X
X
X
X

12.2(2)
T

XAPM
XICMP Path Jitter
XFrame-Relay (CLI)
XMPLS/VPN Aware
XXFTP Get

XXUDP Jitter One 
Way Latency

XXXDLSw+
XXXDHCP
XXXDNS
XXXHTTP
XXXUDP Jitter
XXXXTCP Connect
XXXXUDP Echo

XXXXSSCP(SNA)
XXXXXICMP Echo Path
XXXXXICMP Echo

12.2(25)S12.1(1)T
12.2

12.0(5)T
12.0(8)S12.0(3)T11.2Feature/Release

* Not all IP SLAs can be configured using IPM
*

*
*

IOS Versions that Support IP SLAs Tests
As illustrated above, depending upon the IOS version, IOS devices can be configured to send out synthetic 
upper layer protocol traffic (i.e. HTTP, FTP, Echo, Path Echo, Voice, and more) to a target destination.  
Years ago, the IP SLAs feature was called the Response Time Reporter (RTR) and then the Service 
Assurance Agent (SAA).  Thus, some command lines on the IOS device still refer to the rtr commands.  In 
the table illustrated above and highlights described below is a summary of the IOS versions that support 
specific IP SLAs test operations.

• 11.2 Response Time Reporter (RTR) is first introduced.
• 12.0(3)T Echo, pathEcho, tcpConnect and udpEcho operations are introduced  
• 12.0(5)T The RTR feature is replaced by the Cisco SAA feature. The Jitter operation is introduced.
• 12.1(1)T One way latency and FTP Get Operations are introduced
• 12.2(2)T Support for Frame Relay, VoIP, and MPLS VPN Monitoring features are introduced. The 

“Application Performance Monitor (APM)" feature is introduced, although it becomes fully operative 
starting from 12.2(13.7)T.

• 12.2(11)T IP SLA for ATM is introduced.
• 12.3(4)T IP SLA for Voice Over IP UDP operation is introduced.
• 12.3(14)T, the keyword “rtr” in the IOS command line interface will be replaced with “ip sla”.

Note(s):
• For information about verifying whether IP SLA is available on your Cisco IOS software, type show rtr 

application or show ip sla application (v12.3(14)T or later). This command tells you the IP SLAs 
version, the protocols that are supported, the number of collectors that are configured, and the number 
of collectors that can be configured.
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Helpful Links to More Information

To learn more IPM:
www.cisco.com/warp/customer/cc/pd/wr2k/nemo/prodlit/index.s
html

To learn more IP SLA:
http://www.cisco.com/warp/public/732/Tech/nmp/ipsla/

To obtain links to all references on IPM, IP SLA, CiscoWorks, 
and other related topics, refer to Chapter 5

References
Above is are quick links to more information on the web.  Please refer to Chapter 5 for a complete list of 
references on these and related topics.
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Chapter 2Chapter 2

Using IPM & IP SLAs Using IPM & IP SLAs 
to Monitor Network to Monitor Network 
Service LevelsService Levels
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Chapter 2 Outline

• Important Terminology

• Workflow for Using IP SLAs / IPM
The steps to monitor the network service levels 
using IP SLAs & IPM

• Getting Started
The upfront tasks before you begin running tests 
on the network

• Configuring IP SLAs Using IPM

• A Closer Look at the IPM Test 
Operations

• Viewing Performance Data

Chapter 2 Outline
This chapter contains a quick overview of how IPM works – first some important terminology and then a 
quick look at the workflow for using IPM to configure IP SLA.
Additionally, this chapter will assist the CiscoWorks system administrator or IPM user prepare the network 
devices for use as source routers or target devices within IPM. 
And finally, this chapter will outline the procedures for using IPM to collect and analyze the data collect by the 
IP SLAs in the IOS devices.  
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Important TerminologyImportant Terminology

Important Terminology

• Workflow for Using IP SLAs & IPM

• Getting Started

• Configuring IP SLAs Using IPM

• A Closer Look at IP SLAs Test 
Operations

• Viewing Performance Data
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Important Terminology

Source Router
• IOS Device 
• Generates the synthetic test traffic, 

measures performance, and stores 
statistics in its IP SLA MIB

Target Device
• Receiver of synthetic test operation
• Can be any IP host, Cisco IOS router 

with Responder, or SNA host

Test Operation
• Selected protocol to simulate
• Definition of traffic (frequency, packet 

size, etc.)

Collector
• A single IP SLA test definition in the 

source router

Define Source 
Routers

Define Target 
Devices

Define Test 
Operations

DefineDefine
ScheduleSchedule

+

Collector =

+

+

Important Terminology
Before we explain how to use IP SLAs and configure them in IPM, let’s first review some important 
terminology used to configure IP SLAs using IPM.

• A source router is the originating point from which IPM makes latency and availability measurements. 
Source routers are Cisco IOS routers that have IP SLAs configured to send test packets to target 
devices. The data includes network latency, jitter, availability, packet loss, and errors. Each source 
router must run Cisco IOS software with the IP SLAs feature; use of a current Cisco IOS software 
release, 11.2(18) or 12.3(14) T or later, is recommended.

• A target device is the destination of source router operations (IP SLAs measurements) from which 
response data should be collected. The target device must be reachable by the source router. Also, 
some test operations require specific types of target devices. For example, jitter measurements 
require that the target be another IOS device with IP SLAs (and the IP SLAs responder enabled). 
Additionally, some operations require that the target be listening on specific ports or run specific 
services. For example, HTTP operations require that the target not only listen on the designated TCP 
port, but also provide a response to a URL request. Thus, a target can be one of the following:  an IP 
host, another IOS device with IP SLA, or an SNA host.  (This topic will be discussed in more detail 
later.)

• The traffic test operations simulate actual network traffic for a specific protocol. Source routers 
generate test traffic to measure latency, availability, and jitter for the protocol operation. For example, 
to measure the latency for a Voice over IP (VoIP) session, an Enhanced UDP test operation is created 
and defined to send a series of 60-byte UDP packets with a specified Type of Service (ToS) value and 
target port number. (This topic will be discussed in more detail later.)

• And finally, to define test operation in IP SLA, the user defines a collector in the source router that has 
the IP SLA. A collector is a definition containing the name of the source router, the target device, a test 
operation, and a collection schedule.  A collector can be scheduled to run at any point in time, or 
continuously over any time interval. This flexible scheduler makes IP SLAs suitable for both service-
level monitoring and troubleshooting. 
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Workflow for Using IP SLAs & IPM
Step 1: Determine the Test Requirement

Dave, a new 
application will be 
deployed in the 
server farm soon.  

Can we test the 
application’s latency 
through the network 
to ensure adequate 
response time?

Dave, a new 
application will be 
deployed in the 
server farm soon.  

Can we test the 
application’s latency 
through the network 
to ensure adequate 
response time?

ClientsServer Farm

Sure, Susan.    
Let’s configure IP SLAs 
embedded in IOS devices.  The 
IP SLAs can provide protocol 
latency statistics from the 
server to its clients.  

Sure, Susan.    
Let’s configure IP SLAs 
embedded in IOS devices.  The 
IP SLAs can provide protocol 
latency statistics from the 
server to its clients.  Clients

Internet

Capacity Planning & 
Assessment

• Identify critical services and 
their protocols

• Identify users of services

• Define acceptable network 
latency or response time

Capacity Planning & 
Assessment

• Identify critical services and 
their protocols

• Identify users of services

• Define acceptable network 
latency or response time

Workflow Step 1: Determine the Test Requirement
Before deploying IPM and IP SLAs, put together a service level monitoring plan.  What is it that you are trying 
to assess?  Are you trying to deploy a new application or assess current critical services?  If so, how will it be 
deployed; who will use the new applications; and what would be an acceptable network response time?
The best uses for IP SLAs are capacity planning, service validation, and real-time troubleshooting.  
Therefore, gather information about the network applications, protocols, application users, and the 
acceptable network latency. 

• Capacity Planning – In order to guarantee a certain service level, it is extremely important to assess 
the capacity of the network, the traffic mix, and the traffic pattern.

• Service Validation – Any guarantee requires validation.  A network administrator has to continuously 
monitor the service level to make real-time adjustments and to plan for future services.  

• Real-time Troubleshooting – Just as the traffic in the network is dynamic and changes constantly, so 
does the service level of the traffic.  Real-time monitoring ensures that the level of performance is 
achieved.

After gathering information about the network, determine the test points in the network. Where does the 
traffic start (source router) and where is it going (target device)?  Select existing Cisco IOS routers or place 
other spare routers in the network for generating the test operations.  
Keep in mind that there is no additional cost to deploy IP SLAs, because it is part of Cisco IOS software. 
Similarly, there is no additional device to learn, deploy and manage. It is possible to monitor any given link in 
the network, since Cisco offers a full line of routers (CPE to edge to core).  
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Cisco IOS-Based

IP Service Level Agreements 

(IP SLAs)

Workflow for Using IP SLAs & IPM
Step 2:  Select the IP SLAs Test Operation

ICMP

• Echo
• Path Echo

• Defining a test operation consists of specifying the protocol type, 
the packet frequency, size, and more

• Types of test operations available is dependent upon the IOS version

SNA

• SSCP-LU
• LU0
• LU2

UDP

• DNS/DHCP
• Echo
• Jitter

Application
Configure using IOS CLI

• APM
• Frame Relay 

ATM
• MPLS VPN 

Aware

TCP

• TCP Connect
• FTP
• HTTP
• DLSw+

Workflow Step 2: Select the IP SLAs Test Operation
Depending upon the Cisco IOS software version, various IP SLAs protocol tests are available.  Most of these 
tests are configurable using the IPM application otherwise the test must be configured at the Cisco IOS CLI.  
Use the tables below to determine the best use for the test.  The table below will help you to identify which 
test will provide the best measurement of performance.
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APM - Application Performance Monitor
• (APM) was introduced with Cisco IOS 12.2.2(T). APM operates differently from most IP SLAs test 

operations. Standard IP SLAs operations allow the monitoring of protocol-based activity between 
a source and a destination, while APM operations monitor software application transactions 
between a source and a destination. 

• APM provides a way of monitoring client/server applications between devices by emulating 
application transactions.  

Note(s):
• The APM, Frame Relay, and ATM test operations currently need to be configured and monitored 

using the Cisco IOS command line interface and can not be configured using IPM.
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MIB

IPM 
Client

Source 
Router

Target Device
• Any IP host
• Cisco IOS router
• SNA mainframe

SiSi

IPM Server

Test Packets

4 ms

6 ms

8 ms 25 ms

Step 5: IPM server uses SNMP 
to configure IOS IP 
SLAs  

Step 7: IPM server uses SNMP 
to poll IP SLAs & 
collect test results

Step 5: IPM server uses SNMP 
to configure IOS IP 
SLAs  

Step 7: IPM server uses SNMP 
to poll IP SLAs & 
collect test results

Step 6: IP SLAs in IOS device 
generates synthetic 
test(s) and measures 
latency/response time

Step 6: IP SLAs in IOS device 
generates synthetic 
test(s) and measures 
latency/response time

Step 3: Use IPM client to access the 
IPM server

Step 4: Configure IPM server to 
define IP SLAs 

Step 8: View test results (real-time or 
historical)

Step 3: Use IPM client to access the 
IPM server

Step 4: Configure IPM server to 
define IP SLAs 

Step 8: View test results (real-time or 
historical)

Workflow for Using IP SLAs & IPM
Step 3: Configure IPM and IP SLA

IP SLA

Clients

Server Farm

Step 1: Select Source Router
Step 2: Select Target Device

Step 1: Select Source Router
Step 2: Select Target Device
Step 1: Select Source Router
Step 2: Select Target Device

Step 1: Select Source Router
Step 2: Select Target Device

IP SLA

Workflow Step 3:  Configuring IPM and IP SLA
Once you know what application protocol you are trying to measure, have identified the source and 
destination of the traffic, and have identified an acceptable level of response time, you are now ready to 
identify the source router and target device and then configure the IP SLAs embedded in a source router 
placed near the application server using IPM.  Follow the steps below and the illustration above to get the full 
picture of how it works.

Step 1: The source router selected is either an existing IOS router near the server farm or an IOS 
router placed in the network near the server farm and used only for testing.  The IP SLAs tests 
that can be run depends upon the IOS version on the source router. (Refer to Chapter 1 for a 
table of IOS versions and the tests that they support.)

Step 2: The target device should be a device close to the destination.  It can be any IP host 
(Workstation, a Cisco IOS router, or an SNA host or mainframe.  The type of target device is 
dependent on the test operation chosen.  Some of the more accurate tests require that the 
target device be another IOS router that supports IP SLAs and has the Responder feature 
enabled.

Step 3: Once the source and target devices have been placed in the network and identified, and the 
test operation has been chosen, the user is ready to access the IPM server using either the IPM 
web client (requires Java Plug-in) or the standalone IPM client (requires application to be 
installed on the local machine).  (Access to the IPM client is discussed later in this chapter.)

Step 4. Use the graphical user interface in IPM to configure define the test collector by specifying the 
source router, the target device, the test to run, and when to run the test.

Step 5. Once the collector is defined, IPM uses SNMP to configure the IP SLAs on the source device.
Step 6. Based on the schedule defined in the collector, the collectors will generate the packets from the 

source to the destination and store the measurements in the IP SLA MIB on the source router.
Step 7. IPM will poll the IP SLA MIB and store the results in its database for long term trending.
Step 8. The user can view the results using IPM.
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Workflow for Using IP SLAs & IPM
Step 4: View the Test Results

• Results collected and 
analyzed

– Round trip and one way 
network delay

– Errors: Packet loss, 
busies, drops, missing

– Network delay variation 
(Jitter)

– Service availability

• Proactive notification 
of exceeded 
thresholds

• Historical trending

Workflow Step 4:  View the Test Results
Of course, the last step in the workflow is to view the test results. Every hour, IPM polls the data from the IP 
SLA MIB and stores the data long term in its database.  Without IPM it would be difficult to view and compare 
historical data. 
To view the results, IPM can pull the real-time data directly from the MIB in the source router or IPM can pull 
the data from its database for historical viewing. As you will see later in this chapter, IPM can display the raw 
test data in real-time or historical test data which is aggregated and analyzed statistically.
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Getting StartedGetting Started

• Important Terminology

• Workflow for Using IP SLAs & IPM

Getting Started

• Configuring IP SLAs Using IPM

• A Closer Look at IP SLAs Test 
Operations

• Viewing Performance Data
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Getting Started 
Selecting the Source Router, Target Device

• Source router 
placed in 
network for test 
purposes only

• IOS Release 11.2 
or later 

• Target device can be any 
reachable:

IP Host
SNA host
Cisco IOS device

• A Cisco IOS device with 
the IP SLA responder 
enabled can provide 
more accurate test 
results

I’ll place test routers 
in the network near 

the application server 
and clients

Client

Server
Farm

Source Router Target Device 

Selecting the Source Router & Target Device
As discussed in the previous section, the first two steps when configuring IP SLAs using IPM is to select the 
source and target devices.
In our example network above, Dave chose to place unused Cisco routers into the network as the source 
device and target device so that existing production routers would not have to be used for the test.  The 
source router (test generator) was placed on the same segment where the application server would be 
placed. The source router will compute all the response time measurements. 
The other router is for the target device and was placed on the same segment where many clients would 
access the application server. Remember, the target device can be any one of the following, depending upon 
the type of test you are running:

• IP host - If the target is an IP host, it can be any IP-addressable device such as a network device, 
server, or workstation. Likely candidates for target devices are the actual servers providing application 
services, or devices such as routers that can provide protocol performance measurements for an 
intermediate network segment. 

• SNA host - If the target is an SNA host (IBM MVS mainframe), it must run a Virtual 
Telecommunications Access Method (VTAM) program called NSPECHO, available in the IPM 
product, to measure SNA latency. Optionally, the SNA host can use an SCCP-LU Native Echo.  

• Cisco IOS device with the IP SLA Responder enabled (12.0(3)T or later) – The Responder feature can 
improve the accuracy of the tests.  The Responder can listen and respond to specified port number. 
Additionally, the Responder, based on the type of operation, might put timestamps on the return 
packets for accurate measurement times. 

In our example, Dave chose another IOS router, with the IP SLAs Responder enabled, as the target device. 
This was helpful for measuring packet jitter, responding to specified TCP ports, or removing the processing 
delay in the target device from the overall response time.   
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Getting Started 
Configuring the Source Router

• Ensure the proper IOS version depending upon the type of 
test operation to run

• Configure the SNMP community strings

• Configure SNMP traps

IP SLA

Configuring the Source Router
Once the source of the test operation has been identified and the device has been selected, it will need to be 
configured.
First, check the IOS version of the source router.  IOS release 11.2 is the earliest and first release that 
support the IP SLAs (formerly known as RTR or SAA).  Review Chapter 1 of this tutorial to check which IP 
SLAs test operations are supported in later IOS releases.  
Additionally, a few device configuration commands need to be set in order to configure IP SLAs using IPM 
and have IP SLA-related traps forwarded to a network management station (NMS).  These commands are 
outlined in the figure above and discussed below.

• IPM uses SNMP to define the IOS IP SLA and to extract the data in the IP SLA MIB in the source 
router.  Both the SNMP read-only (ro) and read-write (rw) community strings need to be configured on 
the source router.

• Optionally, to receive traps at a NMS when a test exceeds a specified latency threshold, verify that the 
source router is set up to send IP SLA-generated traps.  The SNMP keyword rtr limits the traps sent to 
the specified address to IP SLA-related traps. If the keyword rtr is omitted, all default SNMP traps are 
sent to the named network management host including IP SLA-related traps.
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Getting Started 
Configuring the Target Device

A target device (destination of test) can be any of the following 
types of devices.  Some configuration may be required.

• Any IP host

• SNA host with VTAM

• Cisco IOS device
– Optionally, configure the SNMP read community string

• Cisco IOS device with IP SLAs responder
– Optionally, configure the SNMP read community string

– Enable the Responder (IOS Release 12.0(3)T or later)

Starting with IOS 
12.3(14)T, the keyword 
“rtr” in the IOS command 
line interface will be 
replaced with “ip sla”.

Starting with IOS 
12.3(14)T, the keyword 
“rtr” in the IOS command 
line interface will be 
replaced with “ip sla”.

Configuring the Target Device
Depending upon the type of target device selected, the target device may need to be configured.  

• IP Host – The host must be reachable by the source device, but no other configuration is needed.
• SNA  Host - It must run a VTAM program called NSPECHO, available in the IPM product, to measure 

SNA latency. Optionally, the SNA host can use an SCCP-LU Native Echo
• Cisco IOS Device - The device must be reachable by the source device and the SNMP read 

community string must be configured.
• Cisco IOS Device with IP SLAs Responder - A target device that is running Cisco IOS software can be 

configured as a Responder, which processes measurement packets and provides detail timestamp 
information. The device must be reachable by the source device and the SNMP read community string 
must be configured.  Additionally, the IP SLAs Responder feature must be enabled.  
The responder has intimate knowledge of Cisco IOS software processing, so it can send information 
about the target router's processing delay back to the source IP SLA. This delay is removed during 
calculation to further improve accuracy.

Note:
• Starting with IOS 12.3(14)T, the keyword “rtr” in the IOS command line interface will be 

replaced with “ip sla”.
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Getting Started 
Understanding the IPM Server & Client

• There are two software components of IPM:  Server & Client
• The IPM server & client may be co-located or separated on 

different platform types
• A license supports 1 server and unlimited number of clients
• Access IPM using the IPM client; two types of clients are 

available
– IPM Web Client applet (access IPM from anywhere; requires Web browser 

with Java Plug-In)
– Standalone IPM client (download & install on your local machine; no Java 

Plug-in required)

CiscoWorks Server
•Common Services 
•IPM Server
•IPM Client (optional)

I can either install the 
IPM client locally or 

access via web 
browser and Java 

Plug-in

Understanding the IPM Server and Client
IPM has a client/server architecture.  The server provides the central services and database functions.  The 
server can communicate through a messaging interface to one or more IPM clients.  
The IPM software consists of separate server software and client software components that can be installed 
on the same workstation or on different workstations. The IPM client/server architecture is cross-platform 
compatible, which allows you to run the client and server software in mixed operating system environments. 
For example, you can run the IPM server on a Solaris workstation and access it from an IPM client running 
on a Windows workstation. 
To access the IPM application, you use the IPM client.  The IPM client software can either be a web applet 
launched from either the IPM server or the CiscoWorks server hosting the IPM server or it can be launched 
from a standalone application installed on your local workstation.  
Let’s look at both of these methods and their advantages/disadvantages:

• IPM Web Client – Using a web browser, a user can access the IPM server from anywhere by first 
launching the IPM Web client applet from a web browser.   This method allows the user to be 
anywhere and get access to the IPM data using a web browser.  However, this method does require 
the user to have the correct version of Java Plug-in installed on their workstation.  (Refer to Chapter 4 
on Java Plug-in version required.)

• Local Standalone IPM Client- Alternatively, if a user accesses the IPM server from the same
workstation all the time and/or they don’t prefer to use the Java Plug-in on their workstation, the user 
may prefer to install the standalone IPM client software on their local machine.  The standalone IPM 
client software is an application that must be installed on the client’s workstation.  The software can be 
installed directly from the IPM installation CD-ROM, or downloaded from either the IPM Web Server or 
CiscoWorks desktop and then installed.
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Getting Started 
Accessing the IPM Client Software

Method 1:  

Access the IPM web 
client applet

Method 2:

Download the standalone IPM client 
software; Then install locally

Accessing the IPM Client Software
Accessing either the IPM web client software or the standalone IPM client is easy.  Simply login to the 
CiscoWorks home page, and select either Client (to access the IPM web client) or Admin to download and 
then install the standalone IPM client software.
In either case, some software needs to be installed.  The IPM web client requires a supported web browser 
(Internet Explorer 6 SP1 or Netscape 7) and the correct Java plug-in version to be installed. The standalone 
IPM client software requires the client software component to be installed from either the IPM Installation CD 
or from the IPM Admin link illustrated above.

Note(s):
• Refer to Chapter 4 for more information on the supported web browsers.
• If using the IPM Web client on Windows, verify your Java Plug-In version by going to the Windows 

control panel.  Select Java Plug-in Control Panel.  From the Advanced tab, view the JRE (Java 
Runtime Environment) version.  LMS v2.5 requires JRE 1.4.2_04.
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Getting Started 
Method 1:  Launching the IPM Web Client

IPM Client Main Window 

Method 1:  Launching the IPM Web Client
You can access the IPM server using the IPM web client Java applet from a Windows or UNIX web browser 
from the CiscoWorks home page.
As illustrated, select Web Client to launch the IPM web client. When the IPM client starts, it displays the IPM 
client main window.  This window will be discussed more in the next section of this chapter.

Note(s):
• Supported Web browsers:  Microsoft Internet Explorer 6 SP 1 or Netscape 7; refer to Chapter 4 for 

more information on browser versions.
• Solaris platform:  If your IPM client hangs when trying to run it as an applet on Solaris, there may be a 

problem with the CLASSPATH environment variable.  CLASSPATH specifies the path to the Java 
class library on your system. However, if CLASSPATH is set in the environment from which you 
launch the Web browser, the Java plug-in cannot function properly, and you cannot run the IPM client 
as an applet.

• The Java Plug-in 1.4.2_04 must be installed on your local system. If not, the user will be prompted to 
install the plug-in when attempting to launch the web client. For more information on this procedure, 
refer to the Installation Guide for instructions on installing the Java plug-in.
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Getting Started
Method 2:  Download & Install the Standalone IPM Client

• Click to download 
standalone IPM 
client software (16 
MB) to your local 
machine from the 
IPM server

• Install and launch 
IPM client 
application locally

Method 2:  Download and Install the Standalone IPM Client
Alternatively, if you will be using IPM from the same Windows or Solaris workstation and don’t prefer to use 
Java, consider installing the standalone IPM client software locally.  
The standalone IPM client software (16 MB) can be downloaded from the Admin>Download Client tab from 
the Internetwork Performance Monitor window in CiscoWorks.  Or the IPM client software can be obtained 
from the IPM Installation CD.  Once the software is either downloaded or obtained, simply install the software 
like all other application software.

Note(s):
• Refer to Chapter 4 for a list of supported Windows and Solaris operating systems for the standalone 

IPM client software.
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Getting Started 
Method 2:  Launching the Standalone IPM Client

From Windows:

From Solaris:

When IPM server and client on same machine:
# /opt/CSCOipm/bin/ipm start client <server name>

When IPM server and client on different machines:
# /opt/CSCOipmClient/bin/ipm start client <server name>

If the Administrative password is enabled, IPM will prompt the 
user to enter the password at the time of launching the client.

If the Administrative password is enabled, IPM will prompt the 
user to enter the password at the time of launching the client.

Method 2:  Launching the Standalone IPM Client
Once the IPM client software is installed on either a Windows or Solaris platform it can be launched like most 
Windows or Solaris applications.  Let’s look at how to launch the server from both of these platform types.
Windows IPM Client
To start the standalone IPM client software from the Windows Start Menu, as illustrated above, or from the 
DOS command line prompt:

• Select Start > Program Files > Internetwork Performance Monitor > IPM Client -
<IPM_server_name/IP_address>
(where <IPM_server_name/IP_address> is the server name or IP address of the default IPM server 
specified during Client installation)

• If multiple IPM servers exist in the network, the user can also specify which IPM server the client 
should access: 
Select Start > Program Files > Internetwork Performance Monitor > IPM Client - Any Server.

Solaris Standalone Client
• To start just the IPM client on a Solaris system that hosts the server as well, enter these commands as 

root:
# cd /opt/CSCOipm/bin
# ./ipm start client

• If the IPM client and IPM server are installed on different Solaris systems, the user must issue the ipm 
start command from a different directory than above, namely:

# cd /opt/CSCOipmClient/bin
# ./ipm start client <server_name>
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Getting Started 
Implementing Client Security

CiscoWorks 
Clients

Remote 
Devices
(SNMP 
Agents)

CiscoWorks 
Server

MIBs

SNMP, Telnet, RCP, …,HTTPS

AAA Server
(Access Control Server)

RADIUS
TACACS

User
Authentication

Secured Socket Layer 
(SSL)

Secured Socket Layer 
(SSL)

Enable/Disable
SSL from CCS

Implementing Client Security
Implementing security features is of high priority these days.  The information that traverses the network 
between the IPM server and IPM client can contain data about the devices in the network.  This information 
can be protected by implementing SSL (Secure Socket Layer).
IPM 2.6 is SSL compliant and enables secure HTTP communication between the client and server. The IPM 
web links from the CiscoWorks Homepage are also SSL-compliant. 
SSL is available in CCS.  CCS uses Secure Socket Layer (SSL) encryption to provide secure access 
between the client browser and management server.  SSL is an application-level protocol that enables 
secure transactions of data through privacy, authentication, and data integrity. It relies upon certificates, 
public keys, and private keys.
You can enable or disable SSL depending on the need to use secure access from the client to the server 
using CCS.  From CCS, click on Server>Security>Single Server Management>Browser-Server Security 
Mode Setup.
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Overview
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• To define a test operation 
(Collector) for IP SLAs using 
IPM, define each of the 
building blocks in IPM

• IPM will use SNMP to write 
the test definition to the IOS 
device (Source Router with 
IP SLA)

• IPM will use SNMP to poll 
the IOS device for the test 
results

Configuring IP SLAs Using IPM
Before we actually use IPM to configure the IP Service Level Agreements (IP SLAs), let’s provide a quick 
overview of what you’ll be seeing in this section, Configuring IP SLAs Using IPM.
Early on, you learned the terminology.  Now, let’s put it to work.  The IP SLA feature in a supported Cisco 
IOS device can be configured by IPM to measure protocol traffic by sending out test traffic on a defined 
schedule.  
To define an IP SLA performance test, the user must configure a collector in the Cisco IOS router (the source 
router).  The easiest way to define the Collector is by using IPM.  A Collector is a definition of an IP SLA test 
to be run by the source router.  The definition consists of a starting point (the source router), a destination 
(the target device), a protocol to test (the test operation), and a collection schedule.  
Once the collector is defined in IPM, IPM will use SNMP to write the IP SLA collector to the Cisco IOS source 
router.  The tests will run base on the defined schedule in the collector.  The source router will store the 
result of the tests in the IP SLA MIB which can then be polled by IPM for viewing.
Now let’s put this to work and configure IP SLAs using IPM! 
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IPM Client Main Window

List of Collectors 
defined in IPM

(maximum 2000)

IPM Client launched using the Web Client; Java Plug-in required.

IPM Client Main Window
When the IPM client is launched, it accesses the IPM server (which could be local or remote), and the IPM 
client main window is display.  The main window consists of a list of collectors already defined in IPM. Thus, 
when IPM is started for the first time, the main window contains no collectors; the list is empty. As collectors 
are configured, they are displayed in this window. Remember, each collector is a combination of a source 
router, a target device, a test operation, and a collection schedule. In addition, each collector also specifies 
the parameters for gathering the statistics, generating event notifications, and scheduling the operation to 
occur.

Note(s):
• If you do not have the necessary CiscoWorks login privileges (Network Administrator user role), the 

Edit menu option in the IPM Client main window will be disabled. This allows only privileged users to 
perform IPM functions such as: add, delete, and edit sources, targets, operations, and collectors. Also, 
to start and stop collectors. 

• Refer to the CiscoWorks Common Services for more information on login privileges, user roles, and 
user authentication and authorization.
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Ways to Define Source and Target Devices into IPM
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Ways to Define Source Routers and Target Devices in IPM
When defining the collector, the user will pick the source routers, target devices, and test operations already 
defined or added to the IPM server.  Source routers and target device can be added to the IPM server using 
one of three methods:

1. Manually using the IPM Client’s Configuration window 
2. Imported from a seed file (Comma Separated Value (CSV) file format) 
3. Imported from a CiscoWorks Device & Credentials Repository (DCR)

The first method, using the IPM Client’s Configuration Window, allows only a single device to be define at a 
time.  This method is discussed next.
The two import methods allow for multiple devices to be added quickly to IPM, thus, populating the list of 
possible source routers or target devices quickly.   A brief look at importing devices from the CiscoWorks 
DCR is discussed after looking at the manual approach using the IPM Client Configuration Window.  
When a new device is added to IPM, IPM first tries to access the device, and then verifies the SNMP 
community strings; and if successful and a Cisco device, IPM determines the device’s IOS version and it’s IP 
SLAs version, formerly known as SAA.  If the information is valid, it adds the device to the IPM database.  
For a device to be added to the list of source routers, the device must have valid SNMP read-only and read-
write community strings and a recent IOS version.

Note(s):
• Refer to the IPM User Guide for more information on using seed files or importing from 

CiscoWorks.
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Manually Defining the Source Router
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Defining the Source Router
To add a source router manually using the IPM Client’s Configuration window follow the steps below and 
illustrated above:

1. Select Edit > Configuration from the IPM client’s main window. (If this menu item is not available, 
check the CiscoWorks privileges for the user logged in; the user must have the role of Network 
Administrator)  The IPM Configuration window displays. The default view is Sources and the list of 
defined source routers displays. 

2. To add a new source router, complete the fields.
• In the Hostname or IP Address field, enter the IP address or host name of the router to use 

as the source for network performance measurements.  
• In the Read Community field, enter the SNMP community name for read access to the 

information maintained by the SNMP agent on the source router.  The default value is public. 
• In the Write Community field, enter the SNMP community name for write access to the 

information maintained by the SNMP agent on the source router.  
• In the Alias Name field, enter a name to assign to the source router. By default, this field 

matches the Hostname or IP Address field, but the name can be modified. 
• In the Description field, enter a brief description of the source router. This is optional.

3. To add a new source router, click Add.  To modify values for an existing entry, select a source 
router from the table, make the appropriate changes in the fields and click Edit.  To delete a router 
from the IPM database, select a source router from the table and click Delete.   To open the 
CiscoWorks Device Center for a selected device, select it and click View.  The Device Center will 
open in a new browser window. You can learn more about the Device Center later in this chapter 
and in Chapter 3.

4. After clicking Add for a new router (or Edit if an existing router), IPM tries to find the router and 
verifies the SNMP community strings.  If the router is found, it adds to the IPM database.   If the 
router is not found, IPM displays an error message.  If an IP address is specified and cannot be 
resolved to a hostname using standard resolution techniques, IPM displays the source router’s IP 
address instead of a hostname.

5. Click Close to save changes and return to the IPM Main window.
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Manually Defining the Target Device
Defining the target device in IPM is just as easy.  Remember, that there are three (3) different types of 
target devices:  an IP host, a Cisco IOS router with the Responder enabled, or an SNA host.  As you’ll see 
below in the steps, you simply need to enter the IP address for a target of type IP Host.  And if the target is 
a Cisco IOS device, also enter the SNMP read community string (if necessary).  IPM will use SNMP to 
query the target and check the IOS version, the IP SLAs version, and whether or not the Responder is 
enabled.  
To add a target device manually using the IPM client’s Configuration window follow the steps below and 
illustrated above:

1. Select Edit > Configuration from the IPM client’s main window. The IPM Configuration window 
displays. Click on Targets to display a current list of target devices.

2. Then set the Target Type field with one of these values based on the type of test(s) you may be 
running:

• IP Host: Any IP addressable device that accepts ICMP requests. 
• Cisco IP SLAs Responder: A Cisco router with Cisco IOS that supports the IP SLA 

software version 2.1.1+.   This type of target will provide more accurate results by 
documenting the arrival time to determine the processing time by the target, responding 
back to specified ports, and helping to measure jitter.  Knowledge of the SNMP Read 
community string is required.  Starting with IP SLA v2.2, IPM can detect whether the 
Responder is enabled or not.  (IP SLA was formerly known as SAA.)

• SNA: A device with a SNA LU Type 0 or Type 2 connection to Cisco’s NSPECHO host 
application, or SNA SCCP-LU Native Echo. You will be prompted for the SNA hostname 
in the PU Name field

3. To add a new target device, complete the fields for a new target and click Add. To modify values 
for an existing entry, select a target, make the appropriate changes, and click Edit. To delete a 
target from the IPM database, select it and click Delete. To open the CiscoWorks Device Center for 
a selected device, select it and click View.  The Device Center will open in a new browser window. 
You can learn more about the Device Center later in this chapter and in Chapter 3.
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Importing Devices from CiscoWorks DCR

Importing Devices from CiscoWorks DCR
If multiple tests are to be setup across the network from various points, it may be helpful to quickly add 
devices (as source routers or target devices) and their SNMP community strings by simply importing the 
information from any registered CiscoWorks DCR (Device and Credentials Repository).
To begin the import process, select the Admin link or tab under IPM.  Then, select Import from Device and 
Credential Repository.  And finally, from the TOC, select Import Devices.
Prior to selecting which devices to import, IPM will ask you which device list to populate.  Are the devices to 
be imported as Source Routers or Target Devices (IOS Responders or IP hosts).  This is important because 
IPM will validate the device information and credentials for each type.  For example, source routers require 
valid SNMP community strings for both read and write privileges. And, an IP host target device only needs to 
be ICMP reachable.
If importing from the CiscoWorks DCR, IPM will attempt to import all the devices in the DCR. To view which 
devices were successfully imported as source routers or target devices, check the respective import log.  A 
link to the log files can be found in the TOC, as illustrated above.
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Viewing Device Information Using CiscoWorks Device Center
From the IPM Client Configuration window, you could have selected a device and clicked View.  This would 
have launched the CiscoWorks Device Center in a separate browser window, as illustrated above.  The 
Device Center serves as a launch point for many other reports and tools that allow the user to view/edit 
information about the device.  Tools are available for doing trace routes and walking the device MIB.  
Reports are available on the device’s hardware modules and software versions.  Or use the Device Center to 
view/edit the devices configuration file or software image.  
A wealth of information at your fingertips!



© 2005 Cisco Systems, Inc. 
All rights reserved.

Introduction 1-51IPM v2.6 Tutorial

Introduction 1-51© 2005 Cisco Systems, Inc. All rights reserved.IPM v2.6 Tutorial

Configuring IP SLAs Using IPM
Selecting the Test Operation - Example

I have the source router and 
target device in place and 

defined in IPM.

Now, I need to choose or define 
a test operation to measure the 

video traffic.

Clients

Server
Farm

Source Router Target Device 

IP SLA IP SLA

Selecting the Test Operation - Example
The next few steps for configuring IP SLAs using IPM is straightforward, if you know what you’re trying to test 
and you have a monitoring plan in place. 
In this next step, the test traffic operation is selected or defined.  The test operation, generated by the IP 
SLAs in the source router, will simulate the actual network traffic for a specific protocol.  
In our example, Dave is trying to measure the response time from where an application server would be 
placed to its primary clients.  That is why he placed the source router at the access point by the server farm 
and the target device at the access point near the clients.
Now for the protocol to test.  The application traffic has been identified as video streams running over UDP.  
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Selecting the Test Operation - Example
To get started quickly, IPM comes with many predefined IP SLA test operations to choose from.  IPM installs 
pre-configured (default) operations for Echo, Path Echo, UDP, TCP, DNS, Enhanced UDP for voice or video, 
DLSw+, and DHCP.  The user can modify and save any of the predefined test operations to meet their 
needs.
To view the existing test operations, open the Operations folder in the IPM Client’s Configuration window by 
clicking on the dial icon next to the Operations folder.
There are several UDP protocol tests that Dave could use to test the response time from the video server to 
its clients.  Let’s look at some of these and see which one would be the best fit.

• Echo or Path Echo – These test operations use ICMP (ping) tests to determine the overall response 
time.  The Path Echo tests will also provide information on the incremental latency on network paths 
that have multiple hops.  This test could be sent to any IP Host.

• UDP (DefaultUDPEcho) – This test operation also provides round trip latency delays.  However, if the 
target device is another IOS device with the IP SLAs responder enabled, then the IP SLAs responder 
could watch for the test operation (by monitoring a specified UDP port) and remove the target’s 
processing time.  This feature is very helpful for determining whether or not it is the network that is 
causing the response time delays.

• Enhanced UDP - These test operations also use UDP for the test packet and require the use of an IP 
SLA responder as the target device.  These tests allow the user to fine tune the packets to more 
accurately representation the actual traffic (packet size, ToS values, etc.).  In addition, information on 
arrival of each test packet is recorded and can be used to calculate jitter in the network delays for 
voice and video applications.
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Defining the Test Operation Settings – Example: Enhanced UDP
In our example, Dave selected the Enhanced UDP test operation since it provided the capability to monitor 
the arrival of the packets at the target device.  This is important for voice and video applications.  If there are 
large variations in the packet arrival at the destination, the quality of the video stream may be poor.  
Additionally, the UDP test operations provide the capability to adjust the packet priority by setting the ToS 
(Type of Service) value in the packet header. This allows the user to see how various application services 
perform when a network applies QoS (Quality of Service) features.
As illustrated above, when a test operation is selected in the IPM Client Configuration window, the settings 
for the test operation are displayed.  The Enhanced UDP test operation is illustrated above.  There are two 
screens to select and view for each of the test operations.  Select the two tabs (Settings, General) to switch 
between the screens and view/modify the parameters for each test operation. 
Additionally, you can set the defaults for each group of test operations by modifying the settings at the folder 
level. 
Settings Tab
By selecting the Settings tab, you can view/modify the primary settings for individual test operations or the 
group of test operations (folder level).  Each test operation has different settings.  For example, many of the 
tests allow you to configure the size of the packet (payload size).  For UDP and TCP tests, you can configure 
the packet priority to test the impact of QoS mechanisms in the network.  Starting with IPM v2.6, the test 
packets can use either IP Precedence (3 bits) or Differentiated Services Code Point (DSCP) (6 bits) in the 
packet header to define the packet classification for prioritization.  
(The next section of this chapter, “A Closer Look at Test Operations”, will provide more details on each of the 
settings for the various test operations, including Enhanced UDP.)
General Tab
By selecting the General tab, you can view/modify the settings related to thresholds and alarm notifications, 
sampling frequencies, and other miscellaneous settings.  
Sometime threshold settings can be a bit confusing, so let’s first look at thresholds and then how to configure 
them on the General Settings tab.
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• Connection Loss and Timeout
• Round Trip Time Threshold
• Average Jitter Threshold
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• IP SLAs can trigger another IP SLA operation for further analysis

Understanding Thresholds
Thresholds are used as a limit that you do not want crossed.  For example, you may not want your network 
utilization to be over 80%.  Thus, your threshold would be 80.  
When configuring thresholds, there is a rising and falling threshold.  Some people say, “who cares about the 
falling threshold.”  But the falling threshold is important.  The reasoning behind the falling threshold is to 
prevent lots of alarms being triggered when the value hovers around the rising threshold marker.
Therefore, after one alert, a new alert will not be generated until the monitored value falls below the falling 
threshold (meaning the value returned to acceptable levels) and then rises back over the rising threshold 
again.
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Configuring IP SLAs using IPM
Configuring Threshold Settings – General Tab 

IP SLA

Defining the Test Operation Settings – General Settings
The configuration window of each test operation and each group of test operations (folder level) contains a 
General tab.  The General settings at the folder level allow you to set parameters common to all operation 
types within that folder. These values define latency and availability thresholds, how often the test operation 
is performed, and the action taken if a threshold is exceeded.
Latency Threshold Settings
IP SLAs provide a proactive event notification feature by using the SNMP trap. Each test operation can be 
configured to monitor against a preset performance thresholds. When this threshold is crossed, IP SLAs 
generate an SNMP trap to alert management applications. This feature is helpful when monitoring the actual 
performance against what was promised in an SLA, by notifying the administrator of potential service-level 
violations. To further expedite problem resolution, IP SLAs can be configured to automatically run a new 
operation when the threshold is crossed. This feature, combined with hop-by-hop measurement capability, 
allows for immediate real-time problem analysis when a problem arises. 
To check poor response time, change the Generate Action Event under Latency Threshold Settings from 
Never to one of the following: 

• Immediate: Instantly run action if latency exceeds the threshold. 
• Consecutive: Run the action if latency exceeds the threshold consecutively X times. Optionally, enter 

a number of consecutive occurrences. Default is 5.
• X of Y: Run the action if latency exceeds the threshold X out of the last Y times. Optionally, enter a 

number of violations that must occur within a set number. Valid values for X and Y are 1 to 16. Default 
is 5 for both. 

• Average: Run the action if the average of the last X latency measurements exceeds the threshold. 
Optionally, enter a number of operations to average. Default is the average of the last 5 latency 
operations. Example: the collector’s threshold is 5000 ms and the last 3 tries are 6000, 6000, and 
5000 ms. Average is 6000 + 6000 + 5000 = 17000/3 > 5667, which exceeds the 5000 ms threshold.
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Defining the Test Operation Settings – General Settings, continue …
Additionally, define the thresholds by setting a Rising and a Falling threshold for the test operation. If a rising 
threshold is exceeded, the criteria set under Generate Action Event is checked to determine if a violation has 
occurred. A threshold violation triggers the action specified by the Action Event Type.
Threshold notification features within IPM protect network operators from extraneous messages. Operators 
can opt for notice when thresholds are exceeded several times consecutively, on average, a certain 
percentage of the time, or immediately.
Note(s): 

• Only one event is triggered while the latency is above the rising threshold value. The threshold is reset 
when the latency falls below the falling threshold.

• When defining multiple operations, it is useful to preset the values under the General settings window 
at the folder level, such as the Operations folder. This automatically sets the default values under the 
General tab for all new operations created. If using an existing operation as a template, then that 
operation’s values will be used instead by default.

Miscellaneous Settings
To set the frequency that the source router collects data, edit the Sample Interval from 10 to 3600 seconds (1 
hour). The default is 60 seconds. 
Note(s): 

• Collected data is stored locally in the source router for up to two hours.  
• Raw data is aggregated and retrieved every hour by the IPM server and stored in the IPM database. 
• For normal operation, do not set the interval value to less than 60 seconds. An interval of less than 60 

seconds might slow down the network performance. Intervals of less than 60 seconds should be used 
only for short periods of time.

Availability Settings
To monitor availability, enter a Timeout Value to set the maximum response time before the operation times 
out. To generate an alert when a timeout occurs, check the Enable Timeout Action box. If checked, the 
action defined by the Action Event Type field is generated when the timeout value is exceeded. Possible
actions include SNMP traps, NMVT alerts, both traps and alerts, or none. 
Default timeout values are:

• 60000 milliseconds (for TCP Connect operations)
• 9000 milliseconds (for DNS operations)
• 5000 milliseconds (for all other operations)
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Defining the Collector 
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Defining the Collector
Remember, a collector is a definition of a Cisco IOS source router that sends a selected traffic operation to a 
target device on a set schedule. A collector gathers the measurements for latency, availability, and jitter from 
a specific source router to a specific target device using a specific test operation and stores the 
measurements locally in the source router in the IP SLA MIB. IPM can then use SNMP to retrieve, analyze, 
and display the data in the MIB.
The maximum collector duration and number of collectors that can run on a Cisco IOS source router 
depends upon the platform, amount of DRAM, and the Cisco IOS software version.  

• Cisco IOS Release 11.x feature sets support up to 200 collectors.
• Cisco IOS Release 12.0.x and 12.1.x supports up to 500 collectors. 
• Cisco IOS Release 12.2.x does not have a fixed number of collectors. 
Note:  

The maximum number of collectors supported by any given router might be less than the previously 
specified number. This number is dependent on several factors including the router configuration 
buffer size, the amount of DRAM installed in the router, and the type of collectors configured.
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Defining the Collector
To define a collector in IPM, use the IPM Client Configuration window from either the Standalone IPM 
software or the IPM web client.  Remember, when the IPM client is first started the main window opens and 
displays all collectors already defined in IPM. With IPM release 2.6, up to 2000 collectors can be defined in 
IPM. 
The main client window provides a brief description of the collectors’ properties or definitions. Collectors with 
start dates and times earlier than the current date and time and end dates and times later than the current 
date and time are active.  In other words, all collectors scheduled to end before the present time or 
scheduled to start at a future date are inactive.
There are two types of collectors:  

• Statistical – Every hour, IPM stores the data from these collectors in its database.  Both real-time and 
historical data can be retrieved for this type of collector.

• Monitored – IPM goes directly to the source router to retrieve the real-time statistics. The data from 
this collector type is not stored in the IPM database.

To set up a collector within IPM, follow the upcoming illustration and corresponding steps.
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Configuring IP SLAs using IPM
Defining the Collector
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Defining the Collector
From the IPM client, open the IPM configuration window by selecting Edit>Configuration.  This menu option 
is available in both types of IPM client types.   (If this menu item is not available, then you do not have the 
appropriate login privileges to configure IPM.)
Next, follow the upcoming steps to configure the collector.
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Defining the Collector, Continue …
To define a collector in IPM, use the IPM Client configuration window and follow these steps.  

Step Action 
1 To open the IPM client configuration window, select Edit > Configuration from the IPM client 

main window. 
 

2 Click Collectors to display a Collector Settings window. 
 

3 Type a name and brief description for the new collector in the associated fields. 
 

4 Specify the Collector Type.   
o Click the Statistical button to gather and store data in the IPM database.  
o Click the Monitored button to view data in real-time only.     In Monitored mode, 

performance data is not stored in the IPM database. A maximum of 2 hours of data is 
kept in the source router’s RTTMON MIB. 

 
5 Specify the Date Settings.  You can either set the start and end date/times or check the On 

Demand box, which will allow the user to define the test and start the test later. 
 

6 From the appropriate lists, search and select from the lists: 
1. A source router 
2. A test operation to use   
3. A target device, if necessary.  Some test operations (DNS, FTP, HTTP) do not require a 

target device to be specified since the server is already specified in the test. 
 

These three parameters must already be defined or added to IPM.  Use the Search field above 
the lists to help find what you’re looking for by typing in few characters.  When found, select from 
the list. 
 

7 Optionally, if the source router has multiple network interfaces, enter the IP address of the source 
device interface to which the packets are returned from the destination.  If you do not specify an 
IP address, IPM configures collector based on the properties specified in the ipm.env file.  
 

8 To add the new collector, click Add. 
 
To delete a collector from the IPM database, select it and click Delete. 
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Setting a Baseline

Setting a Baseline
IPM allows the user to increase, by a specified percentage (the baseline), the latency threshold for all 
running statistical collectors that have collected at least one hour of data. (Editing the baseline does not 
affect monitored collectors.)
To display the Edit Baseline window, select Edit > Baseline from the IPM Main window.  Enter the new 
baseline to be defined for the database. Valid range is 1 to 999 (percent). The default is 20 (percent). 
For example, if the current average latency is 100 milliseconds and the user specifies a baseline of 50, the 
new latency threshold is 150 milliseconds (50% above the current average latency). 
Note(s):

• If the baseline is modified, then try to edit it again before the first edit is complete on all collectors, IPM 
blocks the second attempt and issues an error message. Wait for the baseline to be updated on all 
collectors before editing the baseline again. 

• On IPM servers with a large number of collectors, the IPM client can seem unresponsive while the 
baseline is being updated. This is due to the high volume of messages being received by the client 
during this time. 

• IPM does not automatically refresh open statistics windows to reflect the new baseline. To see the 
new baseline, close the statistics window and open it again.
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QoS Settings for Test Operations
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QoS Settings for Test Operations
For most IP SLA test operations (UDP, Echo, Path Echo, TCP, Jitter), the user has the ability to configure the 
packet header ToS or DiffServ bits.  These bits allow the packet to be characterized or marked as an 
application type.  Based on the QoS mechanisms deployed in the network routers, the network devices may 
prioritize or queue the packets based on these values.  
IP Precedence uses 3 bits; DSCP (Differentiated Services Code Point) uses 6 bits.
These features allow the user to compare the results (I.e. network latency, packet loss, and jitter) when 
marking packets based on the QoS mechanisms deployed. 
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UDP Test Operations
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UDP Test Operations
Let’s look closer at some of the other predefined UDP (User Datagram Protocol) test operations already 
defined in IPM.
UDP Echo Tests
The UDP Echo operation calculates UDP response times between a Cisco router and any IP-enabled device. 
Response time is computed by measuring the time taken to send a datagram and receive a response from 
the destination device. If the target is a Cisco router, the user has an option to enable the IP SLA responder 
in the target router (available in Cisco IOS version 12.1(2)T or later). The responder would either listen to the 
default UDP echo port (port 7), or to the port that the user specifies. Using the IP SLA responder feature can 
increase accuracy as the process delay in the target router is assessed. If the destination is a regular IP host, 
then the user must use UDP port 7 as the destination port.
Note(s):

• Almost all IP devices provide an UDP Echo Service that listens on port number 7 and responds to 
client requests (echo server). Cisco routers also have this service but turned off by default. If the echo 
server is enabled on the target Cisco Router and if the user tries to start an UDP operation that tries to 
communicate with responder on port number 7, the responder will fail because of socket bind problem 
(port number 7 already being used by echo server).  If the user intends to use the responder, then they 
should not try to specify a port that might already be in use by other services on the router. 

• In order for a Cisco router to respond to UDP ports above 1023, the router must support IP SLAs and 
have the IP SLA responder feature enabled and the target must be configured as type “Cisco IP SLA 
Responder” in IPM.
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UDP Test Operations, continue …
DNS/DHCP Tests
Domain Name System (DNS) response time is computed by calculating the difference between the time 
taken to send a DNS request and the time a reply is received. The DNS operation queries for an IP address 
if the user specifies hostname, or queries for a hostname if the user specifies an IP address.
The Dynamic Host Configuration Protocol (DHCP) operation measures the round trip time taken to discover 
a DHCP Server and obtain a lease from it. IP SLAs releases the leased IP address after the operation.  
There are two modes for the DHCP Operation. By default, the DHCP operation sends discovery packets on 
every available IP interface on the router. However, if a specific server[(config)# ip dhcp-server <server-ip>] 
is configured on the router, discovery packets are sent only to that DHCP server. 
UDP Jitter (Enhanced UDP) Tests
With the addition of real-time traffic like voice traffic over IP networks, the focus shifts not just in the reliability 
of the network, but also on the delays involved in transmitting the data. Real-time traffic is delay sensitive. In 
the case of voice data, packet loss up to some extent is manageable, but frequent losses impair 
communication between endpoints.
The UDP Jitter operation was designed to measure the delay, delay variance and packet loss in IP networks 
by generating UDP test traffic. The Jitter operation sends N packets, each of size S, from source router to a 
target router (which requires IP SLAs responder enabled) each T milliseconds apart. All these parameters 
are user configurable. In Cisco's encoding implementation, if G.729 CODEC is used, then frames are 
generated every 10 ms and an RTP payload size of 10 bytes. Cisco gateway combines two such frames and 
transmits them every 20ms. So, the Jitter operation defaults values are set to these values to simulate voice 
traffic. By default 10 packets are sent for each operation.
The packets sent out to measure Jitter carry packet sequence (sending sequence and receiving sequence) 
information, as well as sending and receiving timestamps from the source and the responder. Based on this 
information, Jitter operation is capable of measuring:

• Per-direction inter-packet delay variance (jitter)
• Per-direction packet-loss 
• Average round trip time
• One-way delay (requires IOS 12.1(2) T or later) - Theoretically, the delay incurred by packets 

traversing a route from host A to host B is equal in each direction. However, the true delay in one 
direction may be much higher than in the other direction.  Consider a busy freeway, on which gridlock 
may occur in only one direction. The same situation exists within networks. There may also be 
asymmetric paths between source and destination. The one-way delay computations provide more 
detailed information to the user about their network. Users can gain a better understanding of where 
and in which direction network bottlenecks exist. The UDP Jitter operation provides these 
measurements. However, one-way delay measurement requires the clocks on source and target 
routers synchronized, e.g., using GPS-based Network Time Protocol (NTP) server.   The default 
Enhanced UDP Operations are illustrated below:
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Round-Trip Delay Computations
This figure can help you to understand how the round trip latency values are computed. 
As illustrated, when using the IOS Responder as the target device (available in Cisco IOS version 12.1(2)T 
or later), processing delays can be minimized by computing the target’s processing delay time and 
subtracting it from the total round-trip time.  
Routers sometimes take tens of milliseconds to process incoming test packets, due to other high priority 
processes.  This delay affects the response times computed, because the reply to test packets might be 
sitting on queue while waiting to be processed.  Therefore, the response times would not accurately 
represent true network delays. 
IOS IP SLAs minimize these processing delays on the source router as well as on the target router (if the 
IOS Responder is being used), in order to compute true round-trip times. It does so by time stamping the test 
packets at the target device.
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ICMP Test Operations
Let’s look closer at some of the predefined ICMP (Internet Control Message Protocol) test operations already 
defined in IPM.
Echo Tests
The ICMP Echo operation measures end-to-end response time between a Cisco router and any IP-enabled 
device. Response time is computed by measuring the time taken between sending an ICMP echo request 
message to the destination and receiving an ICMP echo reply. The test operation provides an option to 
compute response time on a specific path with LSR option in IP packet. The tests also allow a user to 
measure Quality of Service (QoS) between endpoints by setting IP Precedence or DSCP bits on an IP 
packet.
Path Echo Tests
The ICMP Path Echo operation computes hop-by-hop response time between a Cisco router and an IP 
device on the network. It discovers the path using traceroute and then measures response time between the 
source router and each intermittent hop in the path. If there are multiple equal cost routes between source 
and destination devices, path Echo operation has the capability to identify a specific path by using LSR 
option (if enabled on intermediate devices). This feature enables IP SLAs to discover paths more accurately, 
as compared to a typical traceroute.
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TCP Test Operations
Let’s look more at some of the TCP (Transmission Control Protocol) test operations.
TCP Connect
The TCP Connect operation computes response times by measuring the time taken by the source router to 
perform a TCP connect operation to the destination device.  If the target is a Cisco router, the user has an 
option to enable the IP SLA Responder in the target router. If the destination is a non-Cisco IP host, then the 
user must specify a well-known port number. Some well-known ports are: 21 (ftp), 23 (telnet), 80 (HTTP 
Server).  This operation is useful in simulating Telnet or HTTP connection times.

FTP
File Transfer Protocol (FTP) carries a significant amount of traffic. The purpose of FTP throughput operation 
is to measure the time it takes to transfer a file from a remote ftp server to the Cisco source router.  The 
source router must be using IP SLAs v2.20 or later. The priority of the traffic can be set using IP Precedence 
or DSCP.  Additionally, the FTP session can be configured to be an active session where a control 
connection is opened (port 21) and a data session (port 20); or a passive session can be setup where only 
the data session is setup and the port number is specified.  
Provide a website URL to use for the FTP request in the following format:  

ftp://user:passwd@servername/dir/file

The FTP test operation can be very useful in characterizing the capacity of a network.
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TCP Test Operations, Continue …
HTTP
The HTTP operation measures the Round Trip Time (RTT) taken to connect and access data from a 
HTTP server. The HTTP server response time measurement is split into three different steps: 

1. RTT taken to perform domain name lookup
2. RTT taken to perform a TCP connect to the HTTP Server
3. RTT taken to send a request and get a response back from the HTTP Server (the operation 

retrieves the object specified by the URL)

DLSw+
Data Link Switching Plus (DLSw+) is the enhanced Cisco version of RFC1795. DLSw+ tunnels Systems 
Network Architecture (SNA) traffic over IP backbones via TCP. The routers performing the tunneling of 
SNA traffic into TCP/IP are referred to as DLSw peers.
The IP SLAs DLSw+ operation measures the DLSw+ protocol stack and network response time between 
DLSw peers. DLSw peers normally communicate through TCP port 2065. 
A prerequisite to successfully running the IP SLAs DLSw+ operation is to have a connected DLSw+ peer 
between the source and destination Cisco devices. On the source DLSw+ device, an operation can be 
defined for a DLSw+ partner peer. The peer (target router) does not have to run an IP SLA-capable 
image.
The default SNA Echo Operations are listed below.

SNA Echo 
Operation

Protocol 
Type

Mode 
Name

Request 
Payload 
(bytes)

Respons
e Payload 
(bytes) 

DefaultSnaLu0Ec
ho

SNA LU0 INTERAC
T

64 64

DefaultSnaLu2Ech
o

SNA LU2 D4A3278
2

64 64

DefaultSnaSSCP
Echo

SNA 
SSCP

N/A N/A N/A
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Gathering Performance Data
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Gathering IP SLAs Performance Data
Once a collector is downloaded and active on a Cisco IOS source router, the IOS source router generates 
test traffic packets of the specified protocol, size and transmission interval as defined in the collector.  The IP 
SLAs measures the response times from the responding test packets.  These raw measurements are the 
real-time statistics stored in the source router.
Then, once every hour, the source router aggregates all the test measurements into a single sample value 
for each network performance statistic. The source router stores a maximum of 120 minutes of statistics in its 
history table.
The statistics calculated include (but are not limited to): 

• Maximum & minimum latency
• Average latency, average maximum and average minimum latency

IPM gathers the aggregated data from the source router once per hour and stores it in the IPM database.  
Since IPM collects the source router’s aggregated statistics, it is not possible to get historical statistics from 
the database which are less than 1 hour.
IPM also provides a real-time feature that allows you to display the data without waiting for the one-hour data 
collection interval. However, the data displayed in the Real-Time window is not stored in the IPM database.
IPM provides an extensive set of reports and graphs for viewing and analyzing the collected performance 
metrics, real-time or historical. Let’s look at how the user can view the IP SLAs performance data using IPM.
By default, IPM stores the collected data for the following periods:

• Hourly data for up to 32 days 
• Daily data for up to 180 days 
• Weekly and monthly data forever 

The IPM database preferences file allows you to control these parameters and also define the business 
hours and days.  To change the preferences, use a text editor to change the file: ipmDbPref.conf
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Viewing Collector’s Properties

Select one of the 
items listed to 

obtain the details 
about it

Select one of the 
items listed to 

obtain the details 
about it

Viewing Collector’s Properties
When troubleshooting or you need more information about a collector, the configuration of its source router, 
target device, traffic operation, schedule, and thresholds can be viewed using the IPM client.  
From the IPM client's main menu, first select the collector, then select View>Properties from the main menu.  
The Properties Viewer window is displayed.  From this window, you can select either Collector, Source, 
Target, or Operation and view its current configuration.
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Viewing Performance Data in IPM
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Viewing IP SLAs Performance Data
Real-Time Statistics 
Real-time statistics for each test collector can only be viewed from the IPM client application. To see these 
statistics, select the collector in IPM client’s main window and select View > Real Time Statistics. Statistics 
display as the frequency interval elapses. Data points are added to the graph for each polling interval (default 
is 60 seconds; configurable from 10 to 3600 seconds). To change the frequency interval of the test operation, 
use the IPM client to edit the General values for the test operation.
Historical Statistics 
Historical statistics are hourly averages on round-trip latencies, errors, and threshold conditions for the 
selected operation between source router and target device. The statistics come directly from IPM database. 
IPM retrieves the IP SLAs aggregated data every hour and stores it in the database.
To view Historical statistics from the IPM client, select the collector in IPM client’s main window and select 
View > Statistics. The Statistics Data Filter window appears. This window displays a date range for which 
data is available. Change the start and end dates as needed. 
Historical data can be displayed in increments of hourly, daily, weekly, or monthly. Although the collector’s 
sampling frequency ranges from every 10 to 3600 seconds (60 seconds by default), the smallest detail for 
viewing historical statistics using IPM is one hour. IPM analyzes the data and calculates maximum, 
minimum, and average values. Hourly averages are averaged again to provide daily statistics. The same 
process occurs for weekly and monthly data. 
Note(s):

• The selected test operation must be of type statistical (not monitoring), to display historical statistics.
• To view raw test results that is not averaged every hour, select Real-Time statistics.
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Viewing Performance Data in IPM 
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Real-Time Statistics
Once a monitored or statistical type collector is actively running, it can be selected in the IPM client window 
and real-time statistics can be immediately polled from the collector by selecting View>Realtime Statistics.
A blank timeline graph, like the one illustrated above is displayed and updated based on the user specified 
Sample Interval time.   When the window is first opened, the collector’s current raw data point is plotted.  
From that point on and will the window remains open, IPM continuously retrieve the next data point from the 
source router based on the sample interval. The data is only retained and graphed while the window is open.  
Once the IPM client window is closed, the real-time statistics that have already past in time can not be 
redisplayed; once the real-time statistics window is closed, only the aggregated hourly statistics are available 
for display.  
If the collector is of type statistical, then the real-time statistics will be aggregated every hour by IP SLAs and 
the aggregated data will be retrieved by IPM, analyzed, and stored for long-term trending.
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Viewing Performance Data in IPM 
Historical: End-to-End Analysis
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Historical End-to-End Analysis
For all test operations, these three standard historical graphs can be created from IPM:

• Round-trip latency – average maximum, average, average minimum, minimum, and maximum
• Errors – The types of errors will vary depending upon the test operation.  For example:  Total packet 

loss in each direction, total busies, sequence errors, drops, missing in action, or late packets
• Completion summary –Total number of attempts, how many were completed, had errors, or exceeded 

the defined threshold
The performance statistics are all plotted on time-based graphs. This easily depicts bottlenecks or potential 
problems during a specific time. Historical data can be filtered based on a time/date range and can be 
averaged over a period of hours, days, weeks, or months. 
Note(s):

• For voice or video applications, the round-trip latency should be less than 150 ms or voice quality may 
be impaired.
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Viewing Performance Data in IPM 
Hop-by-Hop Path Analysis
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Hop-by-Hop Path Analysis
It is important when troubleshooting network delays to measure end-to-end delay as well as source router to 
each routed hop along every possible network path. This helps network operators diagnose exactly where 
the network bottlenecks are occurring.
As illustrated above, the ICMP Path test operations allow the user to view the delay from the source device 
to the target device for every possible network path.  For IP Path Echo operations, additional latency 
statistics are available. Therefore, for the IP Path Echo operations, the following graphs are available:

• For each possible network path, the total end-to-end round-trip delay (illustrated above by selecting 
the Path List folder)

• When selecting a path id, the round-trip delay between the source router and each router hop within 
the selected network path (illustrated on next page)

• When selecting a device within a path, the round-trip latency, error reasons, and completion summary 
between the source the device selected.

Note(s):  
• The number of network paths is determined, but is limited by specifying the maximum number of hops 

and maximum number of paths to be tested in the test operation. 
• IPM provides more than just performance information for each hop. IPM also provides error and 

threshold violation statistics. This information is useful in helping a network operator diagnose the 
cause of the performance bottleneck.
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Viewing Performance Data in IPM 
Hop-by-Hop Path Analysis
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Hop-by-Hop Path Analysis
When one of the network paths is selected (as illustrated above), the overall latency is broken down on a 
hop-by-hop basis.  Within each network path, the round-trip delay between the source router and each router 
hop within the selected network path is measured and analyzed statistically.    This helps network operators 
diagnose exactly where the network bottlenecks are occurring.
Additionally, the user can select a device within the path.  IPM provides more than just latency information 
from the source device to the selected device; IPM also provides error and threshold violation statistics. This 
information is useful in helping a network operator diagnose the cause of the performance bottleneck.
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Viewing Performance Data in IPM 
Voice Over IP Analysis – What is Jitter?

TimeTime

TimeTime

Transmits

Receives

AA CC

tt22 > t> t11

Sender Receiver
PBX PBXNetworkNetwork

BB DD
Evenly 
Distributed 
Packet 
transmittal

AA BB CC DD
tt11

tt33< t< t22
Positive Jitter

tt44=t=t33

EE

EE

Negative Jitter Zero Jitter

tt22 tt33 tt44

tt00 tt00 tt00 tt00

Voice Over IP Analysis - What is Jitter?
If a source device sends multiple packets consecutively to a destination at ten millisecond intervals, and if the 
network is operating optimally, the destination should receive them at ten-millisecond intervals. 
However, delays (i.e. queuing, or arriving through alternate routes) in the network can cause inter-packet 
arrival delay of greater or less than ten milliseconds. 
Positive jitter implies that the packets arrived at intervals of more than ten milliseconds. If they arrive twelve 
milliseconds apart, then positive jitter is equivalent to two milliseconds. Negative jitter is computed similarly.  
Greater value for positive jitter is undesirable for voice networks, and a jitter value of zero is ideal for delay-
sensitive networks.
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Viewing Performance Data in IPM 
Voice over IP Analysis 
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Voice Over IP Analysis 
In this graph, we used the default Voice IP SLAs operation to measure possible jitter in the network.  This 
test does not use the RTP protocol; the test operation uses Enhanced UDP to measure the consistency in 
network latency.  If jitter is 0, then the latency in the network is consistent.  
This is clearly seen in the illustration.  In the small “Round-Trip Latency” graph, we see a spike in network 
end-to-end latency.  Clearly, the voice packets will be delayed, resulting in an inconsistent arrival time of 
packets.  A jitter value of 400 ms will definitely be noticed in a voice conversion.
A network analyst can use information such as this to determine why and how often spikes like this occur.  
And if occurrence is frequent, then network design changes, such as QoS features, may be needed prior to 
deploying VoIP applications.



© 2005 Cisco Systems, Inc. 
All rights reserved.

Introduction 1-80IPM v2.6 Tutorial

Introduction 1-80© 2005 Cisco Systems, Inc. All rights reserved.IPM v2.6 Tutorial

Viewing Performance Data in IPM 
Multiple Operations Graph
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Multiple Operations Graph
What a great way to compare the effect of implementing various QoS features (IP Precedence, DSCP) prior 
to the deployment of an application.  Create two or more test operations and vary the parameters; define two 
or more statistical collectors, and run the tests over time; Then compare the results on the same timeline 
using the multi-collector graph.
A multi-collector graph can be created by selecting two or more collectors in the IPM client window and 
select View>Statistics.
In the example illustrated above, we created two IP Echo tests and varied the IP Precedence (no priority, 
high priority).  The collectors were run at the same time.  After a few days, we reviewed the results by 
creating a multi-operation graph.  At certain times, the packets with the IP Precedence of 0 experienced 
greater latency.
Where this latency occurred could be isolated by running IP Path test operations.
Note(s):

• Multi-graphing is available for IP Echo test operations only;  Enhanced UDP, HTTP, or Path Echo test 
collectors can not be multi-graphed.
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Viewing Performance Data in IPM 
Historical Web Reports

Historical Web Reports
Go to the CiscoWorks home page directly or from the IPM client and launch various web reports for the IPM 
statistical collectors that have been actively running. This web page provides links to configuration reports 
and statistical reports generated for latency, jitter, and HTTP statistics collected by IPM from its statistical 
collectors that have data in the IPM database.  The four types of web reports that you can choose from are 
briefly described below:

• Configuration Reports - View the configuration details of the IPM server. These reports has 
information about all the sources, targets, operations, and collectors defined on the IPM server. 

• Latency Reports - View the latency statistics collected by IPM collectors over a period of time. These 
reports provide links to view the daily, weekly, and monthly summaries for latency statistics.  These
reports have links for IP Echo, IP Path Echo, and other non-IP collectors and IP-based services that 
are configured on the IPM server.

• Jitter Reports - View the jitter statistics collected by IPM collectors over a period of time. These reports 
provide links to view the daily, weekly, and monthly summaries for jitter statistics. This data is 
collected by Enhanced UDP type collectors configured on the IPM server. 

• HTTP Reports- View the HTTP statistics collected by IPM collectors over a period of time. These 
reports provide links to view the daily, weekly, and monthly summaries for HTTP statistics. This data 
is collected by HTTP type collectors configured on the IPM server. This report also has links to view 
the alert reports. 

Note(s):
• You can launch the Device Center, discussed earlier, by selecting  the devices in these reports.
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Viewing Performance Data in IPM 
Historical Web Reports
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Historical Web Reports
To best organize all types of collector’s daily, weekly, and monthly information on latency, jitter, and
HTTP, the web reports are split into 4 categories:

• IP-Echo - View the daily, weekly, or monthly aggregated statistics for all IP Echo test operations, 
such as:

• Services - View the daily, weekly, or monthly aggregated statistics for all types of service test 
operations, such as: FTP, DNS, and DHCP, and all other non-IP collector types.

• IP Path - View the daily, weekly, or monthly aggregated statistics for all IP Path test operations, 
which provide the hop-by-hop analysis.

• Alerts – View errors, or threshold violations daily, weekly, or monthly from these reports.  The Alert 
Report gathers and presents all operations that caused an Error% or Over% statistic in the one of 
the Web Reports listed above. Operations with “high,” “medium,” and “low” error or “over threshold”
percentages are highlighted in red, blue, maroon, and black respectively.

When the user selects either daily, weekly, or monthly under Latency, Jitter, or HTTP, they can then select 
from a specific day, week, or month that has data to view, and then select one of the summary categories 
listed above. 

Note(s):
• Hourly statistics can also be viewed.  Open a web report; click on the collector’s name.  The 

collector’s source, target, and test operation is displayed.  In the title of the report, select Hourly.
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Viewing Performance Data in IPM 
Historical Web Reports - Example
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Historical Web Reports - Example
This is an example of a Web Report for all the Enhanced UDP (Jitter) type collectors that have been 
executed and have collected data stored on the IPM server. 
The Historical Web Reports quickly illustrate any deviations from data collected earlier. For example, daily 
reports show the average and maximum latencies per operation for the day. They are also compared to last 
week’s and last month’s averages. The total number of attempts is recorded. Of particular importance is the 
Over% and Error% values reported. 

• Over% refers to the number of successful operations that exceeded the rising latency threshold. 
(Define the latency thresholds when creating the operation with the IPM client.)

• Error% refers to the number of unsuccessful operations. The breakdown as to why the operation failed 
is highlighted in the operations Alert Report.   ( In all IPM Web reports, if the Error % field shows 
100%, then the Avg (average) and Avg Max (average maximum) fields show N/A (not available), 
because no data is available since all the tests failed.)

Web-based reporting gives the user the ease of clicking links for more information. To review threshold 
settings for a specific operation, click the operation and a report displays the definition for the operation. This 
includes: the sampling interval, the rising and falling thresholds, timeout value, and event action.  Also, to 
view hourly reports, click the collector.  This also provides information on the collector such as the source, 
target, and test operation.
Note(s):

• Hourly statistics can also be viewed.  Open a web report, as illustrated above; click on the collector’s 
name.  The collector’s source, target, and test operation is displayed.  In the title of the report, select 
Hourly.
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Chapter Summary

• Use IP Service Level Agreement (IP SLA), embedded in Cisco 
IOS software, to provide a low cost solution to:

» Monitoring network service levels in a routed network
» Verify service level agreements
» Isolate network bottlenecks 

• IPM configures the embedded IP SLAs and gathers the real-
time and aggregated performance statistics.  IPM provides the 
user with:

» A great alternative to configuring IP SLAs at the CLI
» A predefined set of test operations for measuring latency 

for IP, TCP, SNA applications and services
» Reports for viewing real-time and historical IP SLAs 

statistics
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Chapter 3 Outline

• Access IPM using the IPM Web client

• Import source and target device 
definitions from a CiscoWorks DCR 
(Device & Credentials Repository)

• Use IPM to configure a test to show how 
the use of QoS packet marking features  
can improve application response times 
by packet prioritization

Chapter 3 Outline
This chapter contains a case study that illustrates the exact steps, end-to-end, for setting up IPM and running 
several IP SLAs tests to monitor the network latency for a Video application soon to be deployed.  The case 
study will develop a test plan, add devices to IPM by importing them from the CiscoWorks DCR, and execute 
and analyze several IP SLAs test operations.
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Case Study Description

Remote User Block

Server Block

User Block

WAN•New IPTV server to be 
deployed soon in Server 
Block

•Various User Blocks will use 
web clients to access video 
streams from server

•Verify the videos latency 
through the network to 
ensure adequate response 
times

•Compare results using IP 
Precedence to prioritize 
video packets

Case Study Description
Network services have changed dramatically in recent years, most notably due to the addition of voice, 
video, and mission-critical data to existing data traffic. Customers demand reliable network services and 
depend on the network as a productivity tool, so network administrators and service providers must 
guarantee network services and provide Service Level Agreements (SLA) in order to meet the necessary 
performance requirements.  In this case study, we will experience just that.
Network administrators need to verify that the network is delivering the performance expected by the 
applications, hopefully before the applications are deployed! Historically, this type of measurement requires 
dedicated devices or probes being deployed at the source and destination points.  While using probes is a 
feasible method for monitoring performance between a limited number of network hubs, this method of using 
dedicated devices is both cost prohibitive to deploy and difficult to maintain for monitoring between Customer 
Premise Equipments (CPE) and the hubs.
In the case study above, we see that our network administrators will be proactive.  The network manager 
wants to ensure that the deployment of an new IPTV application is successful and the web clients can view 
videos of corporate events without a slow down.  The network administrators are knowledgeable able the IP 
SLAs feature embedded in Cisco IOS software.  IP SLAs can generate protocols tests using different packet 
parameters and measure the network latency end-to-end as well as hop-to-hop.  
In this case study, we will use IP SLAs to measure the network latency from the users to the IPTV server.  To 
simplify matters, the IPM application will be used to configure IP SLAs and viewing the real-time and 
historical performance results.
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Service Level Monitoring Plan
Test Description

Server Block

• Focus on the network 
latency from the Remote 
User Block clients to the 
Server Block

• Place unused Cisco routers 
for running the continuous 
test 

• Deploy CiscoWorks LMS 2.5
• Use IPM Web client (IE 

browser with JRE v1.4.2_04 
installed)

• Import devices from DCR

• Create 3 IP SLAs tests
• IPTV Video (Best Effort)

• IPTV Video (IP Precedence 3)

• IP Path Echo

Target Router 
(RTR Responder 

Enabled)

Remote User Block

S

Source Router

WAN

Service Level Monitoring Plan
You learned in Chapter 2 that the first step to network monitoring is to develop a test plan.  In our case study, 
the network administrators came up with the following key points and monitoring plan.

• The new IPTV video server will be deployed soon to support remote users.  The remote users will be 
able to use the IPTV server to view corporate meetings which occur at the headquarters.  The server 
will be placed in the Server Block with the other servers for easy system administration.

• Looking at the corporate network, most users of the IPTV server will be located in the Remote User 
Blocks.

• For voice or video applications, the round-trip latency should be less than 150 ms or the quality may 
be impaired.

• The network administrators will measure the network latency end-to-end and hop-by-hop from the 
Server Block to a Remote User Block using simulate traffic similar to the IPTV video streams.

• The IPTV video streams have been characterized in the lab using a network analyzer.  The packets 
have been captured and the average packet size and inter-arrival rate has been determined.

• Since many network design changes will be occurring throughout the year, the end-to-end network 
latency tests will run continuously to ensure consistency in the network latency.

• Cisco’s IP SLAs feature embedded in Cisco IOS routers will be used to simulate the traffic and 
measure the latency.  Since the test will be continuously run for a long period of time, the network 
administrators will deploy some unused Cisco 2500 routers that they have sitting on the shelf for the 
source router and the target device.  Using a Cisco router as the target, instead of a user’s 
workstation, will allow the network administrators to monitor Jitter in the arrival time of the packets at 
the destination. The Cisco IOS will be upgraded to 12.1 or later.  

• CiscoWorks LMS Release 2.5 has been purchased and installed to manage the Cisco-based network.  
The IPM web client (Microsoft Internet Explorer with JRE v1.4.2_04 which is packaged with the Java 
Plug-in software required for the IPM web client) will be used to help actively monitor network service 
levels by configuring the IP SLAs and collecting its data. 

• The administrators will use IPM to configure three IP SLAs test operations on the source router.  Let’s 
discuss these tests next.   



© 2005 Cisco Systems, Inc. 
All rights reserved.

Introduction 1-90IPM v2.6 Tutorial

Introduction 1-90© 2005 Cisco Systems, Inc. All rights reserved.IPM v2.6 Tutorial

Select the IP SLAs Test Operations

• Enhanced UDP test operations are 
used to measure voice or video 
traffic streams

– Specify number of packets, packet 
size, inter-packet delay, and IP 
Precedence or DSCP

– Measures end-to-end latency, 
packet loss, delay variance in 
packet arrival time at target, and 
errors

• IP Path Echo test operations are 
used to measure the network latency 
from the source to each hop in the 
network

– Locate the bottlenecks
– View all the possible network paths

ICMP

• Echo
• Path Echo
• Path Jitter

UDP

• Echo 
• DNS/DHCP
• Jitter

Select the IP SLAs Test Operations
The administrators have selected three IP SLAs test operations to configure on the Cisco source router. 
Two of the tests will analyze the impact of using IP Precedence to prioritize the video traffic and the third 
test will help to analyze the latency, hop-by-hop, for all paths in the routed network.  The tests are 
described below.

1. Enhanced UDP test operation for Voice over IP measures round-trip latency, packet loss, and jitter 
in IP networks by generating synthetic UDP traffic, not RTP traffic. The test sends a defined number 
of packets of a defined size from the source to a target with a defined inter-packet delay. 
Both the source and the target must be running version 12.1 or later of the Cisco IOS software, and 
the SA Agent Responder must be enabled on the target.  To enable the SA Agent Responder on 
the target, use the rtr responder IOS configuration command. 
The packets sent out to measure jitter contain packet sequence information, as well as sending and 
receiving timestamps from the source and the Responder.   It measures the following network 
performance statistics: 

• Round-trip network latency
• Per-direction packet loss
• Per-direction arrival time delay variance (jitter)
• Network availability and errors

2. The network administrators know that voice and video are more sensitive to network delays.  Thus, 
a second Enhanced UDP test operation will be setup to vary the IP Precedence level from 0 to 3.  
This will help evaluate the importance of using varies QoS features in routers by prioritizing delay 
sensitive traffic in the network.

3. The last test will be an IP Path Echo test operation.  Since the network has many redundant paths, 
the IP Path Echo test will determine all the possible paths (up to the specified limit and up to the 
maximum hop count) and run latency tests to each hop in each path.  This will allow the network 
administrators to determine where the network latency is occurring if a problem arises.
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Accessing IPM

Launch the IPM 
Web Client

Accessing IPM
Now that we have a test plan in place, let’s use IPM to configure the IP SLAs test operations.  To use IPM, 
launch the IPM client.  In our case study, the system administrators have chosen to use the IPM Web Client 
instead of the standalone IPM client.  
To launch the IPM Web Client, follow these steps:

Step 1. Using a supported web browser (Internet Explorer v6 SP1) with JRE 1.4.2_04, enter the 
CiscoWorks Server URL, which consists of the IP address of the CiscoWorks Server and the 
default TCP port of 1741. 

For example: http://<ciscoworks IP or hostname>:1741
Step 2. Log into the CiscoWorks server using the login username and password that has privileges to 

configure IPM (CiscoWorks Network Administrator user role)
Step 3: From the CiscoWorks home page, find the Internetwork Performance Monitor area and click 

Client.  This will launch the IPM Web Client.
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Access the IPM Web Client

IPM Web Client 
Main Window

Table is empty 
because no IP 

SLAs collectors 
have been defined 

yet in IPM

Table is empty 
because no IP 

SLAs collectors 
have been defined 

yet in IPM

Access the IPM Web Client
After clicking the IPM Client link on the CiscoWorks home page, the IPM main window will be displayed.  To 
launch the Web Client, click Web Client from the Client tab.
If configured to do so in the Java Plug-in Control Panel, the Java Console window will launch, illustrating the 
Java Plug-in version as well as other initialization messages.  
Once the Java applet has been initialized, the IPM Web Client main window will be displayed.  This main 
window displays all collectors previously defined.  Initially, the table will appear empty with only the column 
heading displayed.
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Add Source and Target Devices to IPM
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Add Source and Target Devices to IPM
Once you have access to the IPM client, you are now ready to build your IP SLAs Collector definitions.  
Remember, that is Collector is defined by the source, its target, the test operation, and a test schedule.  
Once defined the collector definition can be downloaded in the source router and and testing can begin.
So let’s start by adding the source and target devices to IPM.  Remember, from Chapter 2, that the devices 
can be defined in IPM by either adding them manually or by importing them from a text file or from 
CiscoWorks’ DCR.  Either way, manually adding or importing, adding source and target devices to IPM is 
easy.  You simply need the IP address and SNMP community strings (read-only, read-write) for the source 
devices; and the IP address and maybe the SNMP read-only community string for the target device, if used 
as a Responder.
Once the devices have been defined, IPM will first check for SNMP reachability.  If SNMP reachable, IPM will 
check its IOS version and add the device to the database.
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Add Source and Target Devices to IPM
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Add Source and Target Devices to IPM
In our case study, all the applications within the CiscoWorks LMS bundle have been deployed and are in 
use.  Thus, the CiscoWorks Device and Credentials Repository (DCR) is already populated with IP 
addresses and credentials for many of the production Cisco devices as well as the routers placed in the 
network just for the IP SLAs tests.
If these IP SLAs tests were the only ones being run, the system administrators probably would just manually 
added the devices one at a time manually and not import all the Cisco devices in the CiscoWorks DCR.  But, 
in this case, the system administrators feel that they will be running some other tests (TCP Connects, HTTP, 
or DNS tests) in the near future that may required the other network devices.
As devices are imported, the status of the import for each device tried is logged to the Import log files.  The 
import feature may take several minutes depending upon the reachability of the devices.  As illustrated 
above, links to view the log files are available from the Admin>Import from Device and Credential Repository
TOC.
Note(s):

• If you import the target devices as IP devices, IPM will only verify reachability and not verify the SNMP 
community string.
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View Devices Imported
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View Devices Imported
After adding source or target devices, either manually or by importing, go to the and view the list of devices 
that were successfully added to IPM.  
Follow the steps below to view the devices and more information about them:

Step 1. From the IPM Client, select Edit>Configuration from the menu.  The IPM Configuration window 
is displayed.

Step 2. To view the list of current source devices, select Sources in the left window pane.  These are 
the Cisco IOS devices already added to IPM and available for use when defining a collector.

Step 3. To view the list of current target devices, select Targets in the left window pane. These are the 
devices already added to IPM and available for use when defining a collector.

Step 4: To view more information about a device, select an item in the device row.  From IPM, you can 
view it’s IP address; and if it was successfully added as a SAA Responder type, you can also 
view its IOS version, SAA version, and if the Responder is enabled or unknown.  IPM can not 
determine if the Responder is enabled unless the SAA version is 2.2 or later.
If the device was added as only an IP host target the IOS version and SAA version fields will be 
left blank.

More information about the device can be obtained by using the features in the CiscoWorks Device Center.  
Select the device, by selecting an item in the device row.  Then click View to launch the CiscoWorks Device 
Center.  Use the Device Center to manage just about everything about the device, including IOS version 
upgrades, changes to the device configuration, and more!
Let’s look briefly at some of the functions available with the CiscoWorks Device Center.
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Obtaining More Details on the Devices
CiscoWorks Device Center

Obtaining More Details on the Devices
Starting with IPM 2.6, the CiscoWorks Device Center is integrated with IPM and can be launched on the 
devices in IPM. The Device Center can be launched irrespective of whether a device is present in the 
CiscoWorks DCR (Device and Credential Repository) or not.
From the illustration above, you can see many of the network management functions available with the 
Device Center.  In the Tools section, you can run a trace route, walk the device’s MIBs, edit the device 
SNMP community strings, or launch CiscoView.
In the Reports section, view information on the device cards, versions, interfaces, Syslog messages, faults, 
connected hosts, and more.
And in the Management Tasks section, upgrade the device’s software image, edit, view, or compare the 
configuration files, and check the device’s credentials.  
For example, if the target device does not have the Responder enabled, then use one of several Device 
Center functions to enable the Responder.  To enable the Responder (use the rtr responder IOS 
configuration command), the network administrator could use Telnet or the Edit Config task in the Device 
Center.
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Defining the Test Operations
Enhanced UDP
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Defining the Test Operations – Enhanced UDP
In our case study, the network administrator selected the Enhanced UDP test operation since it provided the 
capability to monitor the arrival of the packets at the target device.  This is important for voice and video 
applications.  Network administrators can monitor the variations in the packet arrival (jitter) at the destination 
and source; if the variations are large, the quality of the video stream will be poor.  
Additionally, the Enhanced UDP test operation provides the capability to adjust the packet priority. This 
allows the user to see how various TCP and UDP services perform when a network applies quality of service 
(QoS) features.
Starting with IPM 2.6, the user can now set either Differentiated Services Code Point (DSCP) or IP 
Precedence values in the packet header of the simulated traffic. DSCP increases the number of definable 
priority levels to make better per-hop behavior decisions about packet classification and traffic conditioning 
functions, such as metering, marking, shaping, and policing.
In addition to the QoS settings, the simulated traffic frequency and payload size needs to be defined.  The 
network administrators studied the IPTV traffic in their lab and captured the packets using a Sniffer.  The 
average packet size was 1024 bytes.  The packet inter-arrival time averaged about 20 ms.
To define the two Enhanced UDP test operations with different QoS settings, follow these steps:

Step 1. From the IPM Configuration window, open the Operations folder.  Locate and open the 
Enhanced UDP folder.  Locate and select the DefaultVideo test operation.

Step 2. Enter a new test name:  IPTV Application ToS 0.  This will be the test that uses IP Precedence 
with the Best Effort setting 0.

Step 3. Set the QoS fields:  Use IP Precedence, Value 0
Step 4. Set the traffic characteristics:  Packet size: 1024 bytes; 50 packets every 20 ms.
Step 5. Click Add.  The new test operation will be listed.
Step 6.  Repeat the above steps; however, change the test name and the IP Precedence value to 3, in 

order to increase the priority of the packets.  (If the network has QoS queuing mechanisms in 
place, and the traffic load on the network increases, we should see an improvement in latency 
for this test.)
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Defining the Test Collectors
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Defining the Test Collectors
Now that the source routers and target devices have been added to IPM, and the new IPTV test operations 
have been defined, we are now ready to define the three test collectors in the source router.  To define a test 
collector, follow these steps:

Step 1. From the IPM Configuration window, select the Collectors folder.  (If you open the folder, it will list 
all the previously defined collectors.)

Step 2. Enter a name and optional description for the test collector.  
Test 1:  IPTV Application – Best Effort
Test 2:  IPTV Application – IP Precedence 3
Test 3:  IPTV Application – IP Path Analysis

Step 3. Each all three tests, select Statistical as the Collector Type.  This will have IPM store the IP SLAs 
results in the database for future viewing and trending.

Step 4. Enter the start and end dates to run the tests.  If you are not sure when to start the tests, click the 
On Demand checkbox to start the test later.

Tips: The Source, Target, and Operation can be selected from their lists in any order, but if you select the 
Operation first, then IPM then check to see which targets in the list are acceptable for the test type.  
For example, some tests do not need targets and some tests require SAA responders as targets.  
Also, the empty fields above the lists of devices and operations allow you to search for something in 
the list by typing in the first few characters.

Step 5. Select the operation.  Tests 1 and 2 will use the newly created Enhanced UDP tests.  Test 3 will 
use the DefaultIpPathEcho test operation.

Step 6. Select the source router placed in the Server Block for which the test will be downloaded to and the 
test will start from.  If the source router has multiple interfaces, enter the IP address in the source 
interface to which the response should return.  Refer to Chapter 2 for more information.

Step 7. Select the target device that was placed in the Remote User Block.
Step 8. Click Add to save the test collector definition.
Repeat these steps for all three simulated tests.  
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Analyzing the Results
Enhanced UDP - Jitter Statistics (Best Effort)
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Analyzing the Results – Enhanced UDP (Best Effort)
The test operations were run continuously, and after several days the network administrator looked the 
current historical results.
By selecting the Collector in the IPM Client main window, select View>Statistics.  This view will gather the 
data from the IPM database and display it as illustrated above. Since the test operation was of type 
Enhanced UDP, information on the variance in the time between packet arrivals at both the destination and 
source can be seen in the Jitter graphs.
In our case study, overall, the jitter remain consistent, except in one clear case.
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Analyzing the Results
Enhanced UDP – Latency, Errors (Best Effort)
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Analyzing the Results – Enhanced UDP (Best Effort)
If you scroll down on the Jitter graphs more test data is available, as illustrated above.  
These three standard historical graphs illustrated above can be created from IPM and are available for all 
test operations:

• Round-trip Latency – average maximum, average, average minimum, minimum, and maximum
• Errors – The types of errors will vary depending upon the test operation.  For example:  Total packet 

loss in each direction, total busies, sequence errors, drops, missing in action, or late packets
• Completion Summary –Total number of attempts, how many were completed, had errors, or exceeded 

the defined threshold
From these graphs, we can clearly see a spike in the network latency, occurring around midnight, at the 
same time that the Jitter spiked.  
Tip:

• The system administrators could now use the IP Path Echo test to locate the hop that incurred the 
spike in latency.
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Analyzing the Results
Enhanced UDP - Jitter Statistics (IP Precedence - 3)
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Analyzing the Results – Enhanced UDP (IP Precedence – 3)
Now let’s compare the same test with the test where the QoS settings marked the video traffic with a high 
priority by setting the IP Precedence field to 3, thus, raising the priority of the test packets.  Did the network 
handle the traffic differently?  
The results clearly depict almost identical average Jitter.  The difference occurs when the network had 
become busy shortly before midnight.  When the network was busy, the test operation with Best Effort 
illustrated a significant increase in Jitter; however, the test operation with the IP Precedence field set to 3 did 
not incur an increase in Jitter.  This clearly illustrated the value of setting QoS parameters for delay sensitive 
traffic and implementing QoS mechanisms in the network to handle the traffic.
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Analyzing the Results
Enhanced UDP – Latency, Errors (IP Precedence - 3)
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Analyzing the Results – Enhanced UDP (IP Precedence – 3)
Above are the results of the Enhanced UDP test when the packet priority was increased.
The results clearly depict identical average round-trip latency of 41 milliseconds.  The difference occurs 
again when the network had become busy shortly before midnight. When the network was busy, the test 
operation with best effort illustrated a significant increase in network latency; however, the test operation with 
the IP Precedence set to 3 did not incur an increase in latency. Again, this clearly illustrated the value of 
setting QoS parameters for delay sensitive traffic and implementing QoS mechanisms in the network to 
handle the traffic.
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Refining the Test Operations
Enhanced UDP – Threshold Settings
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Refining the Test Operations – Threshold Settings
The network administrators and designers are happy with the initial results of the tests.  The current network 
latency should not impact the new IPTV application and possible spikes in the network latency could be 
equalized using various QoS mechanisms in the routers.
The tests will continue to run.  And the system administrators have decide to implement SNMP traps on the 
test results so that is the results change, they will be alerted.
To implement threshold settings, the network administrators must edit the test operation and follow these 
steps.

Step 1. Ensure that the source router is properly configured to send SNMP traps to a network 
management system that monitors for events, such as HP OpenView. Remember, the 
CiscoWorks Device Center can be used to edit/view the router’s configuration.

Step 2. From the IPM Configuration window, select the Operations folder. Locate and select the newly 
created Enhanced UDP test operation.  

Step 3. Change the tab to General.
Step 4. Change the Generate Action to Immediate.  This will generate the event type (SNMP trap) 

immediately upon reaching the rising threshold.  To learn about the other settings, refer to 
Chapter 2.

Step 5. Change the Event Type to SNMP traps.  This will cause the source router to send an SNMP 
trap to its configured trap receiver (configured in step 1).

Step 6. The system administrators have decided that they want to be warned if the Jitter threshold does 
reach 200 ms.  Set the rising threshold to 200.

Step 7. Set the falling threshold to 150. The limit violation will be reset once the Jitter falls below 150 
ms.  No additional traps will be sent unless the Jitter falls below the falling threshold after 
reaching the rising threshold.
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Periodic Web Reports

Periodic Web Reports
As the tests continue to run, network administrators can use the CiscoWorks home page to get access to 
Daily, Weekly, and Monthly web reports.  (Hourly reports are also available.  Select the name of the 
Collector.  From the new window, you can view the configuration of the collector, as well as, open Hourly, 
Daily, Weekly, and Monthly web reports.)
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Chapter Summary

• Use IP Service Level Agreement (IP SLA), embedded in Cisco 
IOS software, to provide a low cost solution to:

» Verify network latency prior to application deployment
» Use Enhanced UDP test operations to simulate voice and video 

applications and monitor network jitter
» Use QoS Setting in the test traffic to predict the changes with QoS 

mechanisms deployed in the network
» Use IP Path Echo test operations to locate or isolate network 

bottlenecks 

• Use IPM to configure the embedded IP SLAs and gathers the 
real-time and aggregated performance statistics

• Use CiscoWorks Device Center to manage the Cisco devices 
used in the IP SLAs tests

• Run IP SLAs continuously or periodically and configure SNMP 
traps or alerts to warn network administrator of performance 
changes in the network 
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Chapter 4 Outline

• System Requirements
– CiscoWorks Server

– IPM Client

– Source router (IP SLA) 

• Installation Guidelines
• Upgrade existing system

• New install

• System Maintenance

Chapter 4 Outline
This chapter provides key information and important facts for System Administrators when installing and 
maintaining IPM.  It also highlights IP SLAs device requirements and how to install or configure the IPM client 
to successfully access the IPM server. 
For detailed installation steps or information on upgrading from previous versions of IPM, refer to the IPM 
Installation Guide.  A link to the installation guide can be found in Chapter 5. 
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Hardware Requirements
IPM Server v2.6

• System Hardware*:  
– Sun Ultra I or later
– Pentium processor 750 MHz or better

• Memory*:  512 MB or more; Swap: 1 GB or 
more

• Disk space*:  2 GB
• CDROM drive
• Network Interface Card (NIC)
• Color Monitor
• Printer

* These specifications are for the IPM software only and need to be increased if 
additional applications co-exist.

Hardware Requirements – IPM Server Component v2.6
If your IPM server platform does not host other CiscoWorks software or other applications, the following are 
the minimum hardware requirements to run the IPM server:

• System hardware—Sun Ultra I or later or Pentium 750 MHz
• A CD-ROM drive on the server or, if on Solaris, on a remote host system that can be accessed by the 

Network File System (NFS)
• Memory—512 MB of RAM or more; 1 GB or more swap space
• Hard disk space—2 GB for IPM server and client software
• Color monitor—If you run the IPM client on the host system
• Printer—PostScript-compatible printer for printing graphs and charts
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System Requirements
IPM Server v2.6

• System Software
– Solaris 2.8 or Solaris 2.9 with the required patches from Sun Microsystems 
– Windows 2000 Professional and Server (with SP3 and SP4)
– Windows 2000 Advanced Server (with SP3 and SP4) 
– Windows 2000 Advanced Server Terminal Services (Remote Administration 

mode with SP3 and SP4) 
– Windows 2003 (WS2K3) Server (Standard Edition and Enterprise Edition)

• CiscoWorks Common Services 3.0 (CCS)
– If you ever have to reinstall CCS after IPM is installed, IPM will stop working.  

To integrate IPM back into CCS, type:  ipm cw2ksetup install

• An IPM license supports 1 instance of the IPM server software 
installed

System Requirements – IPM Server Component v2.6
There are two software components with IPM:  the IPM server and the IPM client. The purchase of IPM 
allows a single IPM server to be installed with an unlimited number of IPM clients installed on the same 
platform or different platforms of different operating system types.
As of IPM Release 2.6, The IPM server components can be installed on the following operating system 
platforms:

• Solaris 2.8 or Solaris 2.9 with the latest recommended and required patches from Sun Microsystems, 
Inc.  Refer to the link in Chapter 5 to view the IPM Installation Guide and obtain a list of Solaris 
patches.

• Windows 2000 Professional and Server (with SP3 and SP4)
• Windows 2000 Advanced Server (with SP3 and SP4) 
• Windows 2000 Advanced Server Terminal Services (Remote Administration mode with SP3 and SP4) 
• Windows 2003 (WS2K3) Server (Standard Edition and Enterprise Edition)

Once the operating system software and patches have been installed and/or verified, install the CiscoWorks 
Common Services software (CCS) v3.0.  
Note(s):

• If you have an existing IPM 2.6 and CCS 3.0 installation, and if you re-install CCS, all previously 
installed CiscoWorks applications will stop working. To ensure that IPM continues to work in the same 
state as it was before you re-installed CCS, run this command to integrate IPM back into CCS: ipm 
cw2ksetup install
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System Requirements
IPM Client v2.6

• An IPM client can be either:
– A Web browser with Java Plug-in v1.4.2_04 (J2RE)  - IPM Web Client

• Windows:  Microsoft Internet Explorer 6.0 SP1, Netscape 7.0,7.1, Mozilla 1.7.1
• Solaris:  Netscape 7.0 and Mozilla 1.7; set CLASSPATH variable to null

– Standalone software that comes with IPM and installed on any of the platforms 
below 

• IPM Client can be installed on IPM server platform or alone
• IPM Client can be installed on the following platforms:

– Solaris 2.8 or Solaris 2.9 with the recommended patches from Sun
– Windows 2000 Professional and Server (with SP3 and SP4)
– Windows 2000 Advanced Server (with SP3 and SP4) 
– Windows 2000 Advanced Server Terminal Services (Remote Administration mode 

with SP3 and SP4) 
– Windows 2003 (WS2K3) Server (Standard Edition and Enterprise Edition)
– Windows XP Professional

• An IPM license supports an unlimited number of IPM clients

System Requirements – IPM Client Component v2.6
An IPM Client component is required to access the IPM server.  This client can either be simply a supported 
web browser with the Java Runtime Environment with the Plug-in installed or it can be a standalone software 
component that is installed on the local machine.  The web browser provides a flexible environment, but 
requires the use of Java; and the standalone Web client requires a software application to be installed on the 
user’s local machine.  This standalone IPM software comes with the IPM product and can be installed on an 
unlimited number of workstations.
Either IPM client component can be used on the following platforms.  These are the same platform types as 
the IPM server, with the addition of Windows XP Professional.  The IPM client component can be installed on 
the IPM server platform or a different platform and the operating systems do not have to be the same type.

• Solaris 2.8 or Solaris 2.9 with the latest recommended and required patches from Sun Microsystems, 
Inc.  Refer to the link in Chapter 5 to view the IPM Installation Guide and obtain a list of Solaris 
patches.

• Windows 2000 Professional and Server (with SP3 and SP4)
• Windows 2000 Advanced Server (with SP3 and SP4) 
• Windows 2000 Advanced Server Terminal Services (Remote Administration mode with SP3 and SP4) 
• Windows 2003 (WS2K3) Server (Standard Edition and Enterprise Edition)
• Windows XP Professional 

<continue… next page>
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System Requirements – IPM Client Component v2.6, continue …
The standalone IPM client component can be obtained from the IPM Installation CD or downloaded from the 
IPM server (as discussed in Chapter 2).  
The IPM web client requires a web browser with the Java Plug-in v1.4.2_04 installed. The Java™ 2 Runtime 
Environment, Standard Edition (JRE) v1.4.2_04 is packaged with the Java Plug-in software required for the 
IPM web client.  The web browsers supported are as follows:

• Windows Clients: Microsoft Internet Explorer versions 6.0 SP1, Netscape Navigator 7.1, or 7.0, or 
Mozilla 1.7.1

• Solaris Clients: Netscape Navigator 7.0 and Mozilla 1.7
Note: The Solaris environment variable CLASSPATH specifies the path to the Java class library on 
your system. However, if CLASSPATH is set in the environment from which you launch the Web 
browser, the Java plug-in cannot function properly, and you cannot run the IPM client as an applet.  To 
prevent this problem, make sure CLASSPATH is not set in the environment from which you launch the 
Web browser by setting its value to null.
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System Requirements
IOS IP Service Level Agreements (IP SLAs) IP SLA

• Embedded in a Cisco IOS router with specific releases and 
available in the following feature sets:

– IP Plus
– Desktop Plus
– IBM
– Enterprise

• Recommended release levels:
– Release 11.3(11) or later
– Release 12.1(3) or later
– Release 12.2(1) or later
– Release 12.3(14)T or later (IP SLAs introduced)

• Required for the Source Router
– Additionally, configure SNMP Community RW and RO Strings 

• Optional as the Target Device
– Enable the IP SLA Responder to listen to test packets and timestamp them
– Configure SNMP Community String RO

System Requirements – IOS IP SLAs
To be manageable by IPM, source routers must be running the Cisco IOS software Release 11.2(18) or later 
with the Cisco IOS IP SLA feature (available in the IP Plus, Desktop Plus, IBM, and Enterprise feature sets).
The following Cisco IOS software releases are minimum software levels on the source router:

• Release 11.2(8)
• Release 11.3(6)
• Release 12.0(5)
• Release 12.0(5)T
• Release 12.1(1)
• Release 12.1(2)T
• Release 12.2(1)
• Release 12.2(2)T
• Release 12.3(1)
• Release 12.3(2)T

The recommended Cisco IOS software releases are:
• Release 11.3(11) or later
• Release 12.1(3) or later
• Release 12.2(1) or later
• Release 12.3(14)T or later

Also, refer to Chapter 2, “Getting Started” section, for more information on configuring the source router and 
target devices.
The IP SLA feature has been renamed throughout the IOS releases. IP SLA is also referred to a the 
Response Time Reporter (RTR) or the Service Assurance Agent (SAA) in earlier IOS releases.
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Installation Guidelines

• System Maintenance
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Installation Guidelines
Static IP Address - Do not use DHCP
Valid DNS address that matches its IP address as well
If multiple NIC cards exist:

• Both IP addresses must be in the DNS
• Modify gatekeeper file to indicate which IP address with which the 

client will communicate with

Installation Menu Options:
• Server and Client
• Server only
• Client only

Do not use NAT/PAT between IPM server and client
Firewalls between IPM server and client

• Allow TCP ports:  1741, 1744, 9088, 1783, 1784
• Standalone client across firewall:  Modify UseGKStandalone property 

in the PM_ConfigMain.properties file to YES

Installation Guidelines
Outline above and described below are key notes to keep in mind when installing IPM.

• The IPM server must have a static IP address and it must be defined on the DNS server.
• If you have a multi-homed machine (multiple NIC cards), each NIC must be configured with a different 

IP address.  Additionally, the following conditions must be met:
• Both IP addresses must be configured in DNS. 
• Because of restrictions in CORBA, only one IP address can be used by the client/browser to 

access the server. Therefore, select one IP address as the external address, with which the 
client will access the IPM server.  Then, modify the gatekeeper file ipmgk.props located in 
IPMInstallDir/CSCOcwbS/etc(Solaris), or IPMInstallDir/server/etc(Windows) directory.  
Replace every instance of external-IP-address with the external IP address you choose, and 
remove the "#" character, from the following lines:
#vbroker.gatekeeper.backcompat.callback.host=<external-IP-address>
#vbroker.se.exterior.host=<external-IP-address>
#vbroker.se.iiop_tp.host=<external-IP-address>
#vbroker.se.interior.host=<external-IP-address>

• The standalone client software is optional.  If the standalone client software is not installed, a web 
browser with Java is used to access the IPM server.  If installing the standalone client, remember that 
it does not have to co-exist with the server.  Install the IPM client only on machines where the users of 
IPM will be located.

• IPM does not support Network Address Translation (NAT), Port Address Translation (PAT) and can 
not be used between the IPM server and client.

• If a firewall exists between IPM server and client, then the following TCP ports need to be opened for 
IPM to work: 1741, 1744, 9088, 1783, and 1784.  Additionally, to use the IPM Standalone client across 
a firewall, the UseGKStandalone property in the IPM_ConfigMain.properties file must be set to Yes.
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Installation Guidelines
Measuring SNA Response Times

Install the Cisco NSPECHO application on the SNA 
mainframe

• OS/390 version 2.4 or later
• VTAM version 4.4 or later

NSPECHO is provided on a disk with the IPM 
software
NSPECHO application needs to be uploaded using 
an upload utility to avoid file format problems and 
converted to partitioned data sets
Establish a communication link between the router 
and mainframe

Measuring SNA Response Times
The IPM software includes the Cisco NSPECHO application needed to measure SNA host-to-router 
response times. NSPECHO is designed for mainframe systems running the IBM OS/390 operating system. 
NSPECHO is supplied on disk and does not require System Modification Program Extended (SMP/E) for 
installation.  To use NSPECHO on your mainframe, the host must be running the following software:

• OS/390 Version 2.4 or later
• VTAM Version 4.4 or later

For OS/2 systems, NSPECHO provides an installation utility that automatically uploads the NSPECHO 
compressed files. These files are uploaded to an MVS host in binary format to data sets that have a fixed 
block (FB) record format (RECFM) and 80-byte record size (LRECL). 
Caution: 

• Using File Transfer Protocol (FTP) to upload the NSPECHO compressed files to an MVS host is not 
recommended because of possible complications with the file format.

After the NSPECHO data sets have been uploaded to the SNA host, they must be converted to partitioned 
data sets.
Now your systems programmer can move the IPM load modules and procedures into the proper libraries and 
to configure VTAM.  Before you can use NSPECHO to measure SNA response times, you must complete 
the following tasks detailed in the IPM Installation Guide:

• Adding the IPM Startup Procedure to PROCLIB
• Defining the NSPECHO Mainframe Host Application
• Defining Router Physical and Logical Units (PUs and LUs)

And finally to use IPM to measure SNA response times on the network, establish a link for communication 
between the mainframe and the router.
All these procedures can be found in the IPM Installation Guide. A link to the installation guide can be found 
in Chapter 5.
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Installation Guidelines
Upgrading from Earlier Releases

Both the IPM server and client need to be upgraded to the 
same version
The IPM server requires CiscoWorks Common Services (CCS) 
to be upgraded to the appropriate level
Backup critical files before upgrading

• IPMDB.db
• .dbpassword
• IPMDB.log
• ipm.env

When upgrading from previous versions, ensure:
• Current operating system (OS) is supported; if not, upgrade OS
• OS patches or service packs are installed

Older data from remote servers can be saved by performing a 
remote upgrade

Upgrading from Earlier Releases
Keep in mind that when upgrading, both the IPM servers and clients must be upgraded, as well as the 
CiscoWorks Common Services.
It is always a good idea to backup important files before upgrading; these include:  IPMDB.db, .dbpassword, 
IPMDB.log, and ipm.env. Make sure these files are backed up after stopping the IPM servers.  If there is a 
failure in the upgrade process or if you terminate the upgrade process, you cannot restore the old database.
Additionally, older versions of IPM may have been installed on older operating systems which may not be 
currently supported.  Please reverify the IPM hardware and system requirements prior to installing IPM.
While installing IPM 2.6, the install process checks for the current version of IPM on your machine. If IPM 2.5 
or IPM 2.4 is installed, it is automatically upgraded to IPM version 2.6. The install mode appears as Upgrade 
rather than Fresh.  The IPM database and seed files from IPM 2.4 and IPM 2.5 are preserved. This data is 
backed up automatically as part of the installation process and then converted to the format used by IPM 2.6. 
The HTML reports are re-generated when you upgrade from IPM 2.4 or 2.5 to IPM 2.6.
When migrating IPM 2.4 or IPM 2.5 data from one machine to IPM 2.6 on another machine on the same 
network, you can perform a remote upgrade to save the data.  Refer to the steps in the IPM Installation 
Guide to perform a remote upgrade.
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• System Requirements

• Installation Guidelines

System Maintenance
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System Maintenance
Server Updates

These links to Cisco.com provide valuable 
information on IPM and other Cisco 
products

• Software Downloads
• Documentation
• Access to Technical Support

Server Updates
The Resources section on the CiscoWorks desktop 
provides links for accessing additional information 
on IPM, other Cisco products, and other customized 
third party links and reference points.
By clicking on More Updates, you can obtain links to 
recently updated products, as illustrated in the upper 
figure, lower right corner.
Additionally, information about IPM software 
updates are available on Cisco's Website, by 
selecting Common Services > Software Center 
Software Update from the CiscoWorks homepage.
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System Maintenance

• Access system information 
from either IPM client type 

– IPM Web client (Admin link)

– Standalone IPM client (File 
menu)

• Viewing the process status 
and message logs provide 
the first steps when 
troubleshooting

Web IPM Client

Standalone IPM Client

System Maintenance
The remaining part of this section discusses the tools and reports available which can help system 
administrators maintain and troubleshoot the IPM server.  
Access to the IPM server’s tools and reports is through the IPM client.  As noted throughout this tutorial, 
there are two types of IPM clients:  the web client and the standalone client.  Either of these client types can 
be used to obtain the system information needed to maintain or troubleshoot the IPM server.
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System Maintenance
Server Information – Web IPM Client

View IPM server status, version 
number, and troubleshooting 
information, such as log files

View IPM server status, version 
number, and troubleshooting 
information, such as log files

Server Information – Web IPM Client
If you prefer to use a web browser and Java, access the administrative area of IPM by going to the 
CiscoWorks home page and select the Admin link under Internetwork Performance Monitor.  The Server Info
link on the Admin tab can be used to view IPM server status, version information, and log files for 
troubleshooting.
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System Maintenance
Server Information – Web IPM Client

The TOC provide links to helpful 
information about the IPM server
The TOC provide links to helpful 
information about the IPM server

Process status 
information provides 
the first clue to when 

there might be 
something wrong

Process status 
information provides 
the first clue to when 

there might be 
something wrong

Process Status – Web IPM Client
Information about the IPM version number, the build date, and the status of the servers running on the IPM server can 
help when troubleshooting the application. 
You can access the server and process status information either from the IPM server's command line or from the IPM 
server's home page, select the Admin tab and then the Server Info link.
Optionally, from the IPM server's command line, enter the following command at the IPM server's command line: ipm 
status [<hostname>]



© 2005 Cisco Systems, Inc. 
All rights reserved.

Introduction 1-123IPM v2.6 Tutorial

Introduction 1-123© 2005 Cisco Systems, Inc. All rights reserved.IPM v2.6 Tutorial

System Maintenance
Process Status – Standalone IPM Client

The same process 
status information is 

available in the 
Standalone IPM client

The same process 
status information is 

available in the 
Standalone IPM client

Process Status – Standalone IPM Client
The services running on the IPM server can also be viewed using the Process Manager utility using the 
standalone IPM client software; select File>Process Mgr Client . The Process Manager displays status and 
detailed information about the IPM processes.   To obtain more detailed information on a process, select the 
process and click Details.
You can also access to the Process Manager utility either from the IPM server's command line or from the 
IPM client's main menu.

• From the IPM server's command line, enter the following command at the IPM server's command line:  
ipm pmstatus [<hostname>]

• Or from the Windows Program main menu on the client’s local machine where the standalone IPM 
client software is installed.

By default, the IPM tab is displayed. To access information about the base service processes, click Services 
on the tab bar.   The Process Management Information window contains the information on the process 
name, system id, and current state of the process. The states are depicted by color and the process can be 
in the following states:  initializing, starting, ready, stopping, or stopped.
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System Maintenance
Log Files – Troubleshooting Information

The server log, console log, and 
troubleshooting log can help the technician 

find reason why there might be problems

The server log, console log, and 
troubleshooting log can help the technician 

find reason why there might be problems

Web IPM Client

Log Files – Troubleshooting Information
The server log, console log, and troubleshooting info links on the IPM Admin menu provide invaluable 
information for a technician to find reasons why there might be issues or problems.  

• The server log file contains information for diagnosing and correcting IPM problems.   The IPM 
processes record and timestamp debug or trace messages which can then be used to determine 
potential problems.

• The console log file contains error and warning messages from the IPM server.
• The troubleshooting info link contains all the information about the IPM server such as:  version 

numbers, hardware specification, install information, memory sizing, file locations, process ids and 
status, and more.



© 2005 Cisco Systems, Inc. 
All rights reserved.

Introduction 1-125IPM v2.6 Tutorial

Introduction 1-125© 2005 Cisco Systems, Inc. All rights reserved.IPM v2.6 Tutorial

System Maintenance
Log Files – Troubleshooting Information

Standalone IPM Client
To view, filter, or find 

messages in the log file, click 
the Log Display tab

To view, filter, or find 
messages in the log file, click 

the Log Display tab

Control the types of messages 
to log from each IPM process

Control the types of messages 
to log from each IPM process

Log Files – Troubleshooting Information
The standalone IPM client also can provide views of the message log files.  Additionally, information in the 
log files can be filtered or highlighted using the standalone Message Log client.
When the Message Log client is launched, the Log Display tab of the Message Log window first displays.  
The window can be used to control the messages generated by enabling the message categories defined in 
the Log Control tab.  For example, above, all types of messages from the SNMPServer process will be 
logged.  To change, simply disable the category and apply.
To display messages logged, click Log Display in the tab bar. This will display all messages generated by the
message categories enabled in the Log Control tab of the Message Log window. 
Additionally, the log display can filter or highlight specific messages based on a specific criteria.  To filter 
through the log files, click New View.  The New View window will allow you to specify criteria for messages to 
be displayed in the Log Display tab of the Message Log window. 
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Reference Materials 
Many Cisco reference documents have been created to help users understand the use of the 
CiscoWorks Internetwork Performance Monitor (IPM) application and the IP SLA Cisco IOS 
feature. However, finding help and documentation can often be a challenge. This reference 
chapter has been created to assist you in your pursuit of additional product information.  Below 
are links to documents and Web pages that provide further details on the IPM product and IP 
SLA. 

 

• Internetwork Performance Monitor (IPM) v2.6 Product Information 
♦ Data Sheet (URL)  

www.cisco.com/en/US/products/sw/cscowork/ps1008/products_data_sheets_list.
html 

♦ Documentation (URL)   
www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/ipmcw2k/ 

♦ User Guide 

♦ Installation Guide  

♦ Release Notes 

♦ Software Updates and Packages (URL)   

www.cisco.com/cgi-bin/tablebuild.pl/ipm-sol 

♦ More Information on IPM (URL)   

www.cisco.com/warp/customer/cc/pd/wr2k/nemo/prodlit/index.shtml 

 

• Related Material 
♦ IP SLA (URL) 

Learn more about IP Service Level Agreements (IP SLAs):  
www.cisco.com/warp/public/732/Tech/nmp/ipsla/ 

 

♦ IOS Support for IP SLA (URL) 

Using the feature navigator, find updated information on the Cisco IOS 
software that supports RTR (IP SLA), visit this web site: 
tools.cisco.com/ITDIT/CFN/jsp/index.jsp 
 

♦ Solaris Patches (URL) 

To obtain the patches, contact your Sun Microsystems representative or 
download them from the Sun web site: 
sunsolve.sun.com/ 
 

♦ LMS Quick Start Guide (URL) 
www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/cw2000_b/lms/lmsm
ar03/index.htm 

♦ Supported Devices and Software Releases (URL)   

♦ IPM Frequently Asked Questions (URL)  
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♦ Online Bug Tracker (On Line URL) 
Search for known problems on the Cisco bug tracking system tool, called Bug Toolkit. To 
access Bug Toolkit, perform the following steps: 

♦ Click on the link above (http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl) 
♦ Login to Cisco.com  
♦ Click Launch Bug Toolkit. 
♦ Locate CiscoWorks Device Fault Manager from the list of Cisco Software 

Products 
♦ Then click Next. 

 
 
 
Technical Notes / White Papers 

♦ Network Management Systems: Best Practices White Paper (URL) 
http://www.cisco.com/en/US/products/sw/cscowork/ps2421/products_white_paper09186a008
008884f.shtml 

The objective of this paper is to provide some deployment guidelines for all areas of network 
management:  Fault, Configuration, Accounting, Performance, and Security (FCAPS).    

♦ CiscoWorks LAN Management Solution (LMS) Deployment Guide (URL)  
http://www.cisco.com/en/US/tech/tk869/tk769/technologies_white_paper09186a00800aea9c.
shtml#servicelevel 

♦ The objective of this paper is to review the steps to properly deploying the LMS suite of 
applications. 

♦ Cost Analysis Using CiscoWorks LAN Management Solution (URL)   
http://www.cisco.com/en/US/products/sw/cscowork/ps2425/products_white_paper09186a008
00a1988.shtml 

The CiscoWorks product family can provide a quantifiable financial and IT benefit to an 
organization, through the automation of routine labor, as well as helping to mitigate network 
degradation due to device failures. While it is difficult to derive an exact figure of the true and 
potential cost savings for every customer situation, the Cost Analysis Tool can provide an 
understanding of the scale of savings involved. At this point, the question that needs to be 
asked is not "What is the cost of the product?" but "What is the cost of NOT using 
CiscoWorks?" 



 
 
a. 

Chapter Questions 

IIPPMM  vv22..66  
TTuuttoorriiaall    

CChhaapptteerr  QQuueessttiioonnss  



IPM v2.6 Tutorial 
 

Questions - 2 © 2005 Cisco System Inc.  IPM v2.6 Tutorial 



  IPM v2.6 Tutorial 

 
Based on the information in the IPM product tutorial, answer these questions. 
 

Q1) In IPM, a (n) _________________ is used to define a combination of a source 
router, a target device, a synthetic operation, and a schedule.  (Choose one.) 

A) Transaction 

B) Monitor 

C) Collector 

D) Performance Agent 

E) Operation 

 

Q2) Which of the following are valid target devices for IPM collectors? (Choose all 
that apply.) 

A) AppleTalk Host 

B) IP Host 

C) IPX Host 

D) SNA Host 

E) Cisco IOS router  

F) Cisco IOS router with IP SLA Responder enabled 

 

Q3) Which of the following is a true statement about configuring a Cisco router as a 
target device? (Select one.) 

A) The type must always be Cisco IOS with IP SLA Responder 

B) The type can be either an IP Host or a Cisco IOS with IP SLA Responder 
depending on the test type 

 

Q4) What are the three methods for adding a source router or target device into IPM?  
(Choose all that apply.) 

A) IPM server’s web interface 

B) IPM client’s Configuration window 

C) Seed File (CSV file) 

D) Selecting the devices from a Campus topology map 

E) Importing from a local CiscoWorks DCR 
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Q5) Which of the following is a true statement about IP SLA test operations? (Choose 
all that apply.) 

A) Generated by any host running desired application to test 

B) Used to measure latency and availability for selected protocol operations 

C) Packets can be marked with a ToS (Type of Service) value to test 
networks using QoS (Quality of Service) features 

D) Test results are measured directly by the IPM server 

E) Test the correctness of the tested application 

 

Q6) Which of the following are operations are performed when the HTTP synthetic 
operation is initiated? (Choose all that apply.)  

A) Resolve the hostname using DNS 

B) Ping the web server for reachability first 

C) Connect to the web server 

D) Search the web site 

E) Download a web page 

 

Q7) Which of the IP SLA test operations allows the user to test one-way delay, jitter, 
and packet loss?  (Choose one.) 

A) UDP Echo 

B) UDP Jitter 

C) ICMP Echo 

D) ICMP Path Echo 

E) TCP Connect 

 

Q8) Which of the IP SLA test operations allows the user to test round-trip delay for 
each routed path?  (Choose one.) 

A) UDP Echo 

B) UDP Jitter 

C) ICMP Echo 

D) ICMP Path Echo 

E) TCP Connect 
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Q9) To place data in the IPM database for historical reporting, which of the following 
collector types must be specified? (Choose one.) 

A) Monitored 

B) Statistical 

C) On-Demand 

D) Real-Time 

 

Q10) A maximum of ________ hours of collected data is kept in the source router. 
(Choose one.)  

A) 2 

B) 8 

C) 12 

D) 24 

 

Q11) Jitter is defined as which of the following? (Choose one.) 

A) The time from when the packet is sent to the time it is received 

B) The time between the packets generated by the source router 

C) The number of packets lost per interval 

D) The difference between the current inter-packet delay and the time for 
the previous inter-packet delay for packets arriving at the target 

 

Q12) Which of the following best describes how the IPM Real-Time Statistics graph 
displays its data? (Choose one.) 

A) Data is retrieved from the IPM database for the user specified time frame 

B) All 120 minutes of the collector data in the MIB history table is retrieved 
and displayed 

C) The current data for the selected collector is retrieved from the MIB and 
displayed; the display updates at a user defined interval 

D) Based on the user selected time-frame, data older than 2 hours is 
retrieved from the IPM database, 2 hours or less from the history table in 
the MIB, and new data from the current value in the MIB 
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Q13) For all types of IP SLA test operations, which of the following historical statistics 
graph types are always displayed? (Select all that apply.) 

A) Bandwidth utilization 

B) Completion summary 

C) Errors 

D) Round-trip latency 

E) Source router CPU and memory utilization 

 

Q14) The Historical Statistics can be viewed in which of the following granularities? 
(Select all that apply.) 

A) Every minute 

B) Hourly 

C) Daily 

D) Weekly 

E) Monthly 

F) All of the above 

 

Q15) The daily, weekly, and monthly reports can be accessed from which of the 
following user interfaces? (Choose all that apply.) 

A) IPM client’s configuration tool 

B) Client email application 

C) CiscoWorks server’s web interface 

D) Device’s command line interface 
 


